
for DAZ STUDIO 4.6



2DAZ Studio User Guide – Table of Contents

Chapter I Navigating the Interface ........................ 6
Section 1.1 – Introduction .............................................................................................. 6

Section 1.2 – Interface Layout ..................................................................................... 6
1.2.1 – Full Service [Beta] ....................................................................................................... 7
1.2.2 – Hollywood Blvd ............................................................................................................ 8
1.2.3 – Self Serve .................................................................................................................... 8
1.2.4 – City Limits .................................................................................................................... 9

Section 1.3 – Customizing the Interface ................................................................ 9

Section 1.4 – Interface Style ......................................................................................... 11

Section 1.5 – Vital Panes ................................................................................................ 11
1.5.1 – The Smart Content Pane ............................................................................................. 12
1.5.2 – The Content Library Pane ........................................................................................... 13
1.5.3 – The Scene Pane .......................................................................................................... 14
1.5.4 – The Parameters Pane ................................................................................................. 15
1.5.5 – The Surfaces Pane ...................................................................................................... 16

Section 1.6 − Wrap-Up ..................................................................................................... 17

Chapter II Building a Scene ................................................ 18

Section 2.1 – Introduction .............................................................................................. 18

Section 2.2 – Finding and Loading Your Content ............................................. 18
2.2.1 – Loading an Actor .......................................................................................................... 18
2.2.2 – Loading Clothing and Hair ........................................................................................... 19
2.2.3 – Loading Props ............................................................................................................. 20
2.2.5 – Content Type Indicators ............................................................................................... 23
2.3.2 – Parenting ..................................................................................................................... 24

Section 2.4 – Scene Navigation .................................................................................. 24
2.4.1 The View Selection Menu ............................................................................................... 25
2.4.2 – DrawStyle Options Menu ............................................................................................. 26
2.4.3 – The Viewport Options Menu ........................................................................................ 27
2.4.4 – The View: Orbit Tool / Rotate / Bank Control ............................................................... 27
2.4.5 – The View: Pan / Dolly Control ...................................................................................... 28
2.4.6 – The View: Dolly Zoom / Focal Zoom Control ............................................................... 28
2.4.7 – The View: Frame / Aim Control .................................................................................... 29
2.4.8 – The View: Reset Control .............................................................................................. 29
2.4.9 – The Camera Cube ....................................................................................................... 29



3DAZ Studio User Guide – Table of Contents

Section 2.5 – Modifying Content ................................................................................ 30
2.5.1 – Translation ................................................................................................................... 31
2.5.2 – Rotation ....................................................................................................................... 32
2.5.3 – Scale ............................................................................................................................ 32
2.5.4 – Fit to (aka Conforming) ................................................................................................ 33
2.5.5 – Other Properties in the Parameters Pane ................................................................... 34

Section 2.6 − Saving and Loading a Scene .......................................................... 35

Section 2.7 – Wrap-Up ..................................................................................................... 36

Chapter III Textures, Surfaces and Materials ....... 37

Section 3.1 – Introduction .............................................................................................. 37

Section 3.2 – Surfaces ..................................................................................................... 37

Section 3.3 – Image Maps .............................................................................................. 38

Section 3.4 – Surface Shaders .................................................................................... 38

Section 3.5 – The Surfaces Pane ............................................................................... 39
3.5.1 – Diffuse Color and Strength .......................................................................................... 41
3.5.2 – Specular Color and Strength ....................................................................................... 42
3.5.3 – Glossiness ................................................................................................................... 43
3.5.4 – Ambient Color and Strength ........................................................................................ 43
3.5.5 – Opacity Strength .......................................................................................................... 44
3.5.6 – Bump Strength ............................................................................................................. 45
3.5.7 – Displacement Strength ................................................................................................ 45
3.5.8 – UV Set ......................................................................................................................... 46

Section 3.10 – Wrap-Up ................................................................................................... 49

Chapter IV Shaping ............................................................................. 50

Section 4.1 – Introduction .............................................................................................. 50

Section 4.2 – Your Selection ........................................................................................ 51
4.2.1 – The Region Navigator Tool .......................................................................................... 51

Section 4.3 – The Shaping Pane ................................................................................. 52
4.3.1 – The Editor Page ........................................................................................................... 52
4.3.2 – The Presets Page ........................................................................................................ 53

Section 4.4 – Saving a Shaping Preset ................................................................... 53



4DAZ Studio User Guide – Table of Contents

Section 4.5 – A Quick Render ...................................................................................... 55

Chapter V Posing .................................................................................... 56
Section 5.1 – Introduction .............................................................................................. 56

Section 5.2 – Your Selection ........................................................................................ 57

Section 5.3 – The Posing Pane ................................................................................... 57
5.3.1 – The Editor Page ........................................................................................................... 58
5.3.2 – The Presets Page ........................................................................................................ 59

Section 5.4 – Posing in the Viewport ....................................................................... 60
5.4.1 – The Universal Tool ....................................................................................................... 60
5.4.2 – The Pose Tool .............................................................................................................. 61

Section 5.5 – Expressions ............................................................................................. 62

Chapter VI Cameras and Views .................................. 66

Section 6.1 – Introduction .............................................................................................. 66

Section 6.2 – Loading a Camera ................................................................................. 66
6.2.1 – Loading a Camera Manually ........................................................................................ 67
6.2.2 – Camera(s) Preset ........................................................................................................ 67

Section 6.3 – Changing your View ............................................................................ 68
6.3.1 – Perspective View ......................................................................................................... 68
6.3.2 – Orthographic Views ..................................................................................................... 69
6.3.3 – Camera Views ............................................................................................................. 69

Section 6.4 – The Cameras Pane ............................................................................... 69
6.4.1 – The Cameras Pane Editor Page .................................................................................. 70
6.4.2 – The Cameras Pane Presets Page ............................................................................... 73
6.5 – Saving a Camera(s) Preset ............................................................................................ 73
6.6 − Wrap-Up ......................................................................................................................... 74

Chapter VII Lights .................................................................................. 75

Section 7.1 – Introduction .............................................................................................. 75

Section 7.2 – DAZ Studio Default Lighting ........................................................... 76

Section 7.3 – Adding a Light ........................................................................................ 76
7.3.1 – Distant Lights ............................................................................................................... 77
7.3.2 – Spotlights ..................................................................................................................... 77
7.3.3 – Point Lights .................................................................................................................. 78



5DAZ Studio User Guide – Table of Contents

7.3.4 – Linear Point Lights ....................................................................................................... 78

Section 7.4 – The Lights Pane ..................................................................................... 78
7.4.1 – The Editor Page ........................................................................................................... 79
7.4.2 – The Lights Pane Presets Page .................................................................................... 82

Section 7.5 – Viewing Through a Light ................................................................... 83

Section 7.6 – The 3 Point Rig ....................................................................................... 84
7.6.1 – The Key Light .............................................................................................................. 84
7.6.2 – The Fill Light ................................................................................................................ 85
7.6.3 – The Rim Light .............................................................................................................. 85
7.6.4 – Spot Rendering Your Lights ......................................................................................... 86

Section 7.7 – Saving a Light(s) Preset .................................................................... 86

Section 7.8 – Wrap-Up ..................................................................................................... 87

Chapter VIII Rendering ................................................................. 88

Section 8.1 – Introduction .............................................................................................. 88

Section 8.2 – The Render Settings Pane ............................................................... 89

Section 8.3 – Render Quality ........................................................................................ 89
8.4 – Render Style ................................................................................................................... 90
8.5 – Dimensions ..................................................................................................................... 90
8.5.1 – Showing the Aspect Frame .......................................................................................... 91
8.5.3 – Pixels ........................................................................................................................... 91
8.5.4 – Aspect .......................................................................................................................... 91

Section 8.6 – Advanced Render Settings .............................................................. 92
8.6.1 – Max Ray Trace Depth .................................................................................................. 92
8.6.2 – Shadow Samples ......................................................................................................... 92
8.6.3 – Shading Rate ............................................................................................................... 93

Section 8.7 – Render Settings Preset ...................................................................... 94
8.7.1 – Saving a Render Settings Preset ................................................................................ 94
8.7.2 – Loading a Render Settings Preset ............................................................................... 94

Section 8.8 – Rendering .................................................................................................. 94
8.8.1 – Rendering the Image ................................................................................................... 95
8.8.2 – Saving the Render ....................................................................................................... 95

Section 8.9 − Wrap-Up ..................................................................................................... 96
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Navigating the Interface
An Introduction to DAZ Studio

Section 1.1 – Introduction
 Learning the ins and outs of any new software can be intimidating.  Finding your way around 
a new interface can be difficult, frustrating and discouraging.  One of the goals in designing the DAZ 
Studio interface was to make it as user-friendly as possible, without sacrificing functionality.  To ac-
complish this we decided to put the power in your hands.

 The first thing you should be 
aware of is that the DAZ Studio inter-
face is completely customizable.  Users 
can dock “Panes” and “Toolbars” virtu-
ally anywhere they desire.  This allows 
you to put the “Tools” and “Actions” that 
you use most right at your fingertips.

 The interface is divided into 
three main sections; the Main Menu 
Bar, the Activity Bar, and the Activity 
Layout.  The “Main Menu Bar” contains 
common high level menus such as File, 
Edit, Help etc.  Each “Menu” contains 
“Submenus” and “Actions”.  The “Ac-
tivity Bar” contains “Activity Tabs” that allow you to choose an “Activity” such as ‘Actors, Wardrobe 
& Props’, ‘Pose & Animate’, ‘Lights & Cameras’, or ‘Render’.  These activities will be discussed in 
greater detail throughout this User Guide.  The rest of the interface is referred to as the Activity Lay-
out.  The “Activity Layout” includes the “Viewport”, panes, and toolbars for your current activity.

Section 1.2 – Interface Layout
 While the interface is completely customizable, we don’t make you build your own from 
scratch.  DAZ Studio ships with 4 “Interface Layouts”, each geared towards a specific level of user.  
You can use these layouts as is, or as a starting point in the creation of your own personalized lay-
out.  To switch layouts, click the ‘Window’ menu on the on the main menu bar, move your cursor over 
the ‘Workspace’ submenu and then click the ‘Select Layout...’ action.  This will launch the ‘Select a 
Layout’ dialog.  From here you can choose one of the four pre-built layouts from the ‘Layout’ drop 
down menu:

• Full Service [Beta]

• Hollywood Blvd

• Self Serve

• City Limits
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1.2.1 – Full Service [Beta]

 “Full Service [Beta]” is designed for novice users.  It is the most user-friendly of the layouts 
and its purpose is to provide an introductory experience to new users while preventing many com-
mon mistakes.  The layout directs the user through a very simplistic workflow, which is fine for nov-
ice users but limiting to most anyone else.  The activities, along the top, guide the user through the 
various steps of creating a 3D scene.  Most users will quickly graduate to another layout and take 
advantage of DAZ Studio’s many features.  Keep in mind that this layout is marked “[Beta]” because 
it is still a work in progress.  For this reason the Hollywood Blvd layout is the recommended layout for 
new users.

Note: While in the Full Service [Beta] layout, the DAZ Studio interface is locked and cannot be cus-
tomized.
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1.2.2 – Hollywood Blvd

 “Hollywood Blvd” is for new users who have a few renders under their belt.  If you’ve gone 
through a few tutorials you should be ready for the Hollywood Blvd layout.  Hollywood Blvd is the 
default layout for DAZ Studio, and as such will be the layout you see when launching DAZ Studio for 
the first time.  This layout is very similar to that of Full Service [Beta], but provides access to more 
tools and actions.  You may notice some of the activities from the Full Service [Beta] layout have 
been removed or combined with other activities.  This is because Hollywood Blvd takes the simple 
step by step approach from Full Service [Beta] and condenses it into a more general form.  With this 
layout, users have more control over their workflow.

Note: This User Guide will be based on the Hollywood Blvd layout.

1.2.3 – Self Serve

 The “Self Serve” layout is a happy medium between the more advanced City Limits layout 
and the beginner’s Hollywood Blvd layout.  Activities are still available along the top to guide the user, 
but once again they have been condensed.  This allows the user to customize each activity to suit 
his/her workflow.  In addition to the condensed activities, the Self Serve layout places more actions 
and tools in the toolbar for the user.  Each activity has different actions in the toolbar to suit that activ-
ity.  The toolbar for each activity can be customized to meet your needs.
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1.2.4 – City Limits

 Finally, the “City Limits” layout represents the culmination of your 3D skills.  The first thing 
users will notice is the lack of activities along the top.  City Limits places everything right at the fin-
gertips of the user.  Additional actions are available in the City Limits toolbars, such as those used for 
content creation.  City Limits is perfect for the user who knows their workflow and doesn’t need activi-
ties as a guide.  Consider switching to City Limits only after you are comfortable with DAZ Studio and 
its many capabilities.

Section 1.3 – Customizing the Inter-
face
 Now that we’ve covered the interface 
layouts that ship with DAZ Studio, let’s talk a little 
bit about how you can customize the interface to 
meet your needs.  The easiest way to customize 
the interface is to drag the various panes to where 
you would like them to be.  To move a “Pane”, 
simply left click and hold while the cursor is over 
the tab that is attached to the edge of that pane.  
You can then drag the pane anywhere on your 
screen.  If you drag the pane towards the cen-
ter of the viewport, it will become a free floating 
“Pane Group.”  You can then move or resize the 
group by left clicking and dragging.  The cursor 
will change to indicate whether you will resize or 
move that group.  A two-way arrow indicates re-
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sizing and will be displayed when your cursor 
is over the outer-most edge.  A four-way arrow 
indicates positioning and will be displayed 
when your cursor is over the bar at the top of 
the group.

 Pane groups can be docked on the left, 
right, top or bottom of the viewport.  To dock 
a group, move it toward the edge of the “Main 
Window.”  A highlight will appear on that side 
of the interface to indicate the “Docking Area” 
that the group will be placed in.  If a pane 
group is already docked in a docking area, you 
can add other panes to that group by dragging 
the pane by its tab and dropping it next to the 
tab of the pane you wish to group it with.

Note: Be aware that pane groups can be docked next to each other 
in the same docking area, creating additional columns or rows.

 The open panes in any particular layout typically only rep-
resent a subset of the panes that are available in DAZ Studio.  To 
add a pane that isn’t currently visible in the interface, click on the 
‘Window’ menu in the main menu bar and choose the ‘Pane (Tabs)’ 
submenu.  From here you can select the pane you wish to open.  
Once the pane appears in the interface you can leave it free floating 
or dock it where you like.

Note: Adding a pane to an existing group can also be accomplished 
by right clicking on the empty portion of a group, next to the tabs, 
and then selecting the pane you wish to add from the ‘Add Pane 
(Tab)’ submenu.

 Feel free to play around with the interface cus-
tomizing features.  Move some panes around, open 
new panes from the ‘Pane (Tabs)’ menu and explore 
a little bit.  If you come up with an interface layout that 
you like, you can save it by going to the ‘Window’ menu 
and selecting the ‘Workspace’ submenu.  From there 
choose ‘Save Layout As…’  or press the F4 key on your 
keyboard - which is the default shortcut for the ‘Save 
Layout As…’ action.  You can name the layout and it will 
be available in the ‘Select a Layout’ dialog in the future.  
If you are unhappy with the changes you’ve made, you 
can reset the layout by choosing one of the four default 
layouts or a previously saved layout from the ‘Select a Layout’ dialog.
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Section 1.4 – Interface Style
 In addition to having a very customizable interface 
layout, the “Interface Style” or appearance of DAZ Studio can 
be customized as well.  DAZ Studio ships with three interface 
styles:

• Mainstreet

• Highway

• Darkside
“Main Street” is the default interface style and consists of large 
icons and text.  The default color scheme for the Main Street 
style consists mainly of a light greys and orange highlights.  The 
Highway style shares the same default color scheme as the Main 
Street Style.  The difference between the two is that Highway has 
smaller icons and fonts, conserving precious screen real estate.  
The Darkside style has icons and fonts similar to Highway with 
narrower margins designed to conserve screen space.  The de-
fault color scheme has dark greys with dark yellows as highlights.  
You can customize the colors for a style by going to Window→ 
Style → Customize Colors...

 The interface style can be changed by choosing Window → 
Style → Select Style…  from the main menu bar.  The ‘Select Style…’ action will launch the ‘Select a 
Style’ dialog.  Use the drop down menu in the top right hand corner of the dialog to select an inter-
face style.  Once you have chosen a style, use the ‘Apply’ button to preview the style or the ‘Accept’ 
button to commit to the style and close the dialog.

Section 1.5 – Vital Panes
 DAZ Studio has several panes, in fact 33 (and 
counting) of them.  It is beyond the scope of this User 
Guide to cover every single pane and its function.  Infor-
mation for that can be found in the detailed Reference 
Guide.  However there are a few panes that are vital to 
the workflow of any user.  It is important that new users 
familiarize themselves with these panes.  They are:

• Smart Content Pane

• Content Library Pane

• Scene Pane

• Parameters Pane

•Surfaces Pane
All five of these Panes can be found in the ‘Actor’s, 
Wardrobe & Props’ activity of the Hollywood Blvd layout.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/referenceguide/start
http://docs.daz3d.com/doku.php/public/software/dazstudio/4/referenceguide/start
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1.5.1 – The Smart Content Pane
 The “Smart Content” pane is one of 
two places that you can load your content 
from.  (For more information on how to load 
content see the Documentation Center arti-
cle: Loading Content).  The Smart Content 
pane displays content in a context-based 
manner.  This means it will only present you 
with content options that are specifically 
designed for whatever you currently have 
selected in your scene.  This is not to say 
that other content will not work, the Smart 
Content pane simply presents you with 
options that are known to be compatible.  
Methods of using those other pieces of con-
tent will be covered in more detail under the 
Content Library section below.  If no scene 
selection is made the pane displays all “Smart Content” that loads an object with geometry (such as 
figures, clothing, hair, props and environments) along with Camera(s) Presets and Light(s) Presets.

Note: The DAZ Content Management Service (CMS) must be installed and running in order for Smart 
Content to display correctly.

 You can navigate the available content by clicking any of 
the categories in the “Category View” on the left.  Selecting 
a “Category” will display all content assigned to that cate-
gory.  Many categories have subcategories to further refine 
what is displayed.  A horizontally pointing arrow will appear 
next to any category with a subcategory.  Click the arrow to 
expand the category and display its subcategories.

 Smart Content provides two ways of browsing content – by file or by product; each of which 
are given their own “Page.”  The ‘File’ page is set as the default, but you can switch to the ‘Product’ 
page by simply clicking the ‘Product’ label near the top of the pane.  On the ‘File’ page, individual files 
are displayed to the user and sorted alphabetically in the “File View.”  The ‘Product’ page displays 
individual “Products”, sorted alphabetically in what is referred to as the “Product View.”  You can still 
filter the products by category, however you won’t be able to directly load anything into the scene 
until you’ve ‘jumped into’ a product.  To do this, simply double-click on the desired product.  All files 
associated with the product will be displayed to you and you can load the content as you normally 
would.

Note: Product browsing does not provide context based filtering.  The current scene selection is dis-
regarded when displaying a product’s contents.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/finding_loading_and_organizing_content/tutorials/loading_content_into_your_scene/start
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 In the Hollywood Blvd layout the Smart Content pane is docked on the left side of the screen 
in the ‘Actors, Wardrobe & Props’ activity.  Feel free to load a figure or some clothing from the Smart 
Content pane.  Just double click an icon to load it.

1.5.2 – The Content Library Pane
 The “Content Library” pane is the second location that you can load content from.  Instead of 
limiting your view of content and suggesting items that will work, the Content Library pane is de-
signed to allow you to navigate through all of the items you have installed.  The pane is divided into 
two areas, the “Container View” where you can browse through folders, products or categories, and 
the “Asset View” where the files are displayed.

  When navigating through your 
content, you can choose to do so in one of 
three ways:

• By format and location

• By product name

• By Category

Browsing by format and location:
 When entering the Content Library 
pane you will see several ways to step 
through your content.  By choosing a specif-
ic format of content (e.g. DAZ Studio For-
mats), you will be directed through a folder 
structure of the content on your system that 
shows all content in the format you have 
selected.  Without going into too much detail 
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‘DAZ Studio Formats’ is where you will find content that is native to DAZ Studio – content like Gene-
sis, Genesis 2 and any of their add-ons.

 DAZ Studio can also import content that is native to Poser® hence the ‘Poser Formats’ 
section.  Poser Formats can include content sold in the DAZ Store.  Figures like Michael 4, Victoria 
4, their respective add-ons and accessories, their predecessors Michael/Victoria 1, 2 and 3 are all 
Poser Format content.

Note: In order for content to show up in the Content Library pane it must be installed to a “Mapped 
Directory” in the “Content Directory Manager.”  You can find more about that here.

Browsing by product name or category:
 The Content Library pane also allows the user to browse by products and by categories.  
Browsing by product will provide the user with an alpha-numeric list of every product they have 
installed.  Under each product you can find the files associated with that product.  The categories 
section mirrors the categories in the Smart Content pane, the only difference is that the files are not 
filtered based on the scene selection.

Note: Product and category browsing require that the CMS is installed and running.  Only “Smart 
Content” will appear within the ‘Products’ or ‘Categories’ containers.

 The Content Library pane is located on the right hand side of the Hollywood Blvd layout.  It 
can be found in this location within each activity.  No matter how you decide to browse, by file and 
format, by category, or by product the process is the same.  You browse in the “Container View” and 
the files in the selected folder, product or category will appear in the “Asset View.”

1.5.3 – The Scene Pane
 The “Scene” pane contains a list of 
every item loaded into the scene.  This can 
include figures, clothing, props, cameras 
and lights, amongst others.  When you load 
an item into the scene you will see it appear 
in the viewport and you will also see it listed 
in the Scene pane.

 So why is the Scene pane so im-
portant?  If you can already see everything 
in the viewport why do you need it in list 
form?  The answer is simple – selectability.  
It is extremely simple to refine your current 
scene selection in the Scene pane.  Any 
selectable item in the Scene pane, whether 
it be a figure, bone, camera, light or prop is 
a “Node.”  All you need to do is look for the 

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/finding_loading_and_organizing_content/tutorials/mapping_directories/start
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node you want to select in the list and click on it (hold Ctrl/
Cmd or shift to select multiple items).  Selecting an item in 
the viewport is possible, but gets complicated when you 
have multiple items in the scene.  The Scene pane is the 
easiest way to accurately select an item in the scene.

Note: When an item is selected in the Scene Pane it is 
highlighted.

 To deselect any currently selected scene item click any 
empty spot in the Scene pane.  You can also click an empty 
area in the viewport.  Right clicking in the Scene pane will 
open a menu with more selection and deselection options.

 Your current scene selection is very important.  It tells the Smart Content pane what con-
tent to display.  It tells DAZ Studio what to do when you load clothing, textures etc.  It governs what 
properties and options are displayed.  Since your current selection is so important in DAZ Studio, the 
Scene pane lets you know at a glance what is selected and allows you to easily change that selec-
tion.

 In the Hollywood Blvd layout the Scene pane is located on the right hand side of the interface.  
It can be found in this location within each activity.  If you loaded content from the Smart Content or 
Content Library panes you should see it listed in the Scene pane.  Feel free to expand or collapse 
the item and practice selecting or deselecting.

1.5.4 – The Parameters Pane
 The “Parameters” pane is where you 
can alter your current scene selection.  In the 
Parameters pane you will find sliders for trans-
lation, rotation, and scale as well as a slew of 
other properties.  The “Properties” that are avail-
able are dependent on the item that is selected; 
some items, such as figures and props, will 
have additional properties for “Morphs“or “Pose 
Controls.”

 The Parameters pane is divided into two 
columns.  Displayed in the left hand column are 
the “Property Groups.”  These serve to organize 
the properties into logical arrays such as Trans-
forms, Morphs, or Display.  You can expand 
a property group by clicking the arrow that is 
next to it.  You can also right click on a property 
group to access further expanding and collaps-
ing options.  Click on a property group or subgroup to select it.
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 At the top of the Parameters pane you can change your 
current scene selection.  Just click on the drop down menu 
at the top of the pane to change your selection.  The menu 
functions like the Scene pane.  You can expand, collapse, 
select or deselect any scene item within this menu.

 Once a property group is selected on the left, the Pa-
rameters Pane will display all properties inside of that group 
on the right hand side.  Most properties appear in the form 
of a “Slider.”  You can adjust the slider to manipulate the 
value of a property, or you can click the numeric value and 
enter a value of your own.  You can even enter basic math-

ematical expressions i.e. (3/5) or (5*2.13).

 The Parameters pane is located on the right hand side of the Hollywood Blvd layout.  If you 
have an item loaded in your scene select it in the Scene pane or from the Parameters pane “Scene 
Selection Menu” and play around with some of the properties that are available in the Parameters 
pane.

1.5.5 – The Surfaces Pane
 In the “Surfaces” pane you can custom-
ize the surface of the object.  Consider it like 
the paint shop of DAZ Studio.  You can cus-
tomize color, specular, glossiness, opacity and 
much more.   In a nutshell, the Surfaces pane 
is where you can go to determine how light 
interacts with the surface, or in some cases the 
volume, of your object.

 Like the Parameters pane, the Surfaces 
pane is divided into two columns.  On the left 
is the “Surface View” where you can see the 
“Surfaces”, “Surface Selection Sets” and prop-
erty groups for your current scene selection.  
Clicking on the arrow to the left of an item will 
expand it.  You can expand an object to see its 
surfaces.  You can select an individual surface 
to edit properties for that surface, or you can 
hold down the shift key to select multiple sur-
faces to be edited simultaneously.
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 On the ‘Editor’ page of the Surfaces pane, on the right hand side, you will see all of the prop-
erties available for the selected surface - these are sometimes referred to as “Channels.”  While it is 
impossible to discuss each property available for a surface there are a few commonly used proper-
ties that are important to know:

• Diffuse Color/Strength

• Specular Color/Strength

• Bump Strength

• Displacement Strength

 “Diffuse Color” changes the actual color of the model, while “Diffuse Strength” determines the 
strength that the color will have.  “Specular Color” determines color of the highlight that the model 
will have.  “Specular Strength” determines the intensity of the highlight.  “Bump Strength” simulates 
roughness over the surface of the model.  “Displacement Strength” will actually change the shape of 
the geometry in the scene when it is rendered.  This is useful for creating fine details without having 
to model them.

 Each channel can be edited in various ways.  The most common way to edit a channel is to 
load an image map.  An “Image Map” is two dimensional image.  DAZ Studio supports .jpg, .png, 
.bmp and .tiff image formats for image maps.  image maps can be loaded by clicking the “Image 
Menu Button” for the property (icon on the left side of the property).

 Fortunately most products come with Material(s) Presets that load the image maps for you.  
These Material(s) Presets can be loaded onto the model from the ‘Presets’ page of the Surfaces 
pane, the Smart Content pane or the Content Library pane.  The Presets page of the Surfaces pane 
can be navigated in the same way as the Smart Content pane.  Material(s) Presets are the easiest 
way to modify the surface of a model.

Note: The “(s)” in Material(s) Preset refers to the fact that the “s” is optional.  A Material(s) Preset can 
affect multiple surfaces or a single surface.

 In the Hollywood Blvd layout the Surfaces pane can be found on the left hand side of the in-
terface.  Go ahead and load a few Material(s) Presets onto your model from the Presets page.  When 
you find a preset that you like go to the Editor page and manually adjust some sliders.  This will give 
you a good idea of what each property does to the surface of the model.  Remember you can always 
double click a preset to quickly revert the surface settings of a model.  Materials, Surfaces and the 
Surfaces pane will be discussed in greater detail in Chapter 3.

Section 1.6 − Wrap-Up
 Now that you have an idea of how the DAZ Studio interface works, how to customize it, 
change the layout and the style you are ready to learn more about the software.  The rest of this 
User Guide will follow a typical workflow for DAZ Studio.  You will learn how to load content, set up a 
scene with actors, props, lights, cameras, etc.  Finally, you’ll learn how to render your scene as a two 
dimensional image or animation so that you can share your work with others.
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Building a Scene
Loading and Modifying Content in DAZ Studio

Section 2.1 – Introduction
 The principles involved in building a scene in DAZ Studio are similar to those involved in 
building a scene for a photo session or a movie shoot.  Depending on your needs you will want a 
background or a “Set”, an “Actor”, “Wardrobe”, “Props”, “Lights” and “Cameras”.  In this chapter we 
will focus on the actor(s), the wardrobe, the props and the set.  By the end of Chapter 2 you should 
be able to load and arrange these elements to create a simple scene.

Note: In this chapter we will be using the ‘Actors, Wardrobe & Props’ Activity, of the Hollywood Blvd 
layout.

Section 2.2 – Finding and Loading Your Content
 As detailed in Chapter 1 here are two primary places for you to load your content from – the 
Smart Content pane and the Content Library pane.  For descriptions of these panes you can refer to 
Sections 1.5.1 and 1.5.2.  In this chapter we will focus on the Smart Content pane because it pro-
vides the easiest way for users to browse their content.

 While it is possible to load content in any order to build your scene, certain workflows are 
more efficient.  The workflow outlined below will allow you to add an actor, clothing, add your props, 
and finally your environment.  This workflow allows you to make adjustments to your actor, wardrobe 
and props without the distraction of a large background.

2.2.1 – Loading an Actor
 Loading an actor is easy with the help of the Smart Content pane.  First open the Smart Con-
tent pane, located on the left side of the interface.  Next, make sure that you are browsing through 
‘Files’ rather than ‘Products.’  You can do this by clicking on the ‘Files’ label near the top of the pane.  
You will be able to see all available ac-
tors by selecting the ‘Figures’ category.  
Expanding the ‘Figures’ category will re-
veal any subcategories and allow you to 
further refine your search.  If you simply 
click on the ‘Figures’ category itself, all 
files in the ‘Figure’ category and all of its 
subcategories will be displayed.  Double 
click any of the icons to load the figure, 
or you can drag the icon and drop it into 
the viewport.

 DAZ Studio comes with several 
figures for you to choose from, free of 
charge.  You can expand your selection 
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by purchasing additional content from the DAZ 3D store.   DAZ Studio also allows you to load multi-
ple instances of a single figure or several different figures into the scene.  For now just load a single 
figure of your choice.  To follow along with this guide we recommend starting out with the Genesis 2 
Base Female.

2.2.2 – Loading Clothing and Hair
 The first thing you probably noticed when you loaded your figure was that she/he loaded both 
naked and bald.  While there is nothing wrong with baldness if it fits your needs, most scenes benefit 
from the addition of clothing and hair to the figures.  Fortunately, loading clothing and hair for your fig-
ure is as simple as it was to load your actor.

 When loading clothing and hair it is important 
to first select the actor that you are loading the clothing 
or hair for.  By default when you load an actor into an 
empty scene it is automatically selected.  However, it is 
good practice to get in the habit of double checking your 
selection.  Open the Scene pane and make sure that 
your actor is selected.  The name of the figure should be 
highlighted and you will also see a bounding box around 
the figure in the viewport to show what is selected.

 Once the actor is selected, open the 
Smart Content pane.  You may notice that 
there are fewer categories on the left.  If you 
recall, the Smart Content pane filters the 
content that is displayed based on the cur-
rent scene selection.  Locate and click on the 
‘Wardrobe’ category.  Any clothing that was 
designed to work with your selected figure 
will appear in the ‘Wardrobe’ category.  You 
can expand the ‘Wardrobe’ category to reveal 
subcategories that may help you further refine 
the content displayed to you.  Go ahead and 

pick some clothing to load; you will probably want to load both a top and a bottom.  You can load the 
items by double clicking the icons or by dragging and dropping the icons onto your actor.

 Now that the figure is clothed we can add 
some hair.  Once again, ensure you have the actor 
selected in the Scene pane and then open the Smart 
Content pane.  Locate and click on the ‘Hair’ catego-
ry and pick a hair that you like.  You can then double 
click the icon or drag the icon onto the head to load it.

http://www.daz3d.com/people
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 DAZ Studio comes with a few free Clothing and Hair items.   You can purchase additional 
content in the DAZ 3D store.

Note: Most clothing and hair should automatically fit to the figure.  If this doesn’t happen, or you don’t 
know what ‘fit to’ means, don’t worry.  Section 2.5.4 will discuss this process.

2.2.3 – Loading Props
 Not every scene will require props.  However, they are a great way to add details to your 
scene that may make the difference between a mildly interesting render and an exciting one.

 In DAZ Studio a “Prop” is any static object (static meaning it can’t be posed) that can be load-
ed into the scene.  Some props are designed to be used with the actor - things like weapons, jewelry, 
etc.  Other props work by themselves - things like tables, chairs, rugs, etc.

 Props can be found in the Smart Content 
pane, under the ‘Props’ category.  Keep in mind 
that if you currently have an actor selected the 
Smart Content pane will filter the content that 
is displayed.  If you don’t have any compatible 
props available then you won’t see the ‘Props’ 
category.  You can deselect your actor by clicking 
any empty area of the viewport.

Note: With a little work most props can work with 
any figure regardless of the figure the prop was 
originally designed for.  It is often a good idea 
to deselect your current scene selection before 
browsing the Smart Content pane for props.  This 
allows you to view all available props.

http://www.daz3d.com/clothing-accessories
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 Deselect your actor and look in 
the Smart Content pane under the 
‘Props’ category to see which props 
are available to you.  You can dou-
ble click the icon to load or drag and 
drop it into the scene.  Dragging 
and dropping is particularly advanta-
geous when the prop is designed to 
be used with an actor.  For example 
you can drag and drop a staff onto 

the hand of an actor, or a necklace onto the neck.  When you drag the icon, hold it over the body part 
until a menu pops up.  You can then choose to parent the prop to that body part.  Holding the Alt/Op-
tion key while dragging an icon will display a drop target that indicates where the object will load.

 When the prop loads in, it may not load perfectly in line with the figure.  You can move the 
prop and pose the figure so that they look natural.  We will learn more about posing in  Chapter 5.  
For now it is sufficient that you be able to load the prop into the scene.

 Once again, DAZ Studio comes with a few props for free, however you will probably want to 
increase the number of props you have.  This can be accomplished by purchasing additional props 
from the DAZ 3D website.

http://www.daz3d.com/environments-props
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2.2.4 – Loading an Environment
 Depending on the needs of your 
scene and your overall vision, you may or 
may not need an environment.  Environ-
ments don’t need to be the focus of the 
scene to be useful.  Often times they add 
flavor, spice, and context to a scene rather 
than dominate it.  They typically add anoth-
er layer to the story you are trying to tell.

 To load an environment, first make 
sure you deselect your current scene selec-
tion so that the Smart Content pane doesn’t 
filter out your environments.  Click on the 
‘Environments’ category to bring up all of the environments available.  You can refine your search by 
expanding the ‘Environments’ category and clicking on any subcategories.

 Often times an environment will be broken into several pieces that can be loaded individually.  
Generally, an environment will include a preset that loads and pieces together the entire set.  These 
presets generally have names like “Preload” or “Load All.”  Find one of these presets and double 
click the icon to load it into the scene.  Alternatively, you can drag and drop the icon into the scene.  
Holding the Alt key on Windows or the Option key on a Mac while dragging an icon will display a drop 
target which allows you to see where the content will be dropped in the scene.

 DAZ Studio comes with some environments for free.  You can purchase additional environ-
ments from the DAZ 3D website.

http://www.daz3d.com/environments-props
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2.2.5 – Content Type Indicators
Content that appears in the Smart Content pane will have a “Content Type 
Indicator” on the top right corner of its icon.  Content type indicators are 
based on the “Content Type” assigned to a file.  The purpose of these indica-
tors is two-fold.  The first is the color, which informs you of what the behavior 
of the file will be when you load it.  The second is the text, which indicates 
what type of file it is - actor, wardrobe, hair, environment, pose, light etc.

 The indicators each have a specific color that corresponds to a spe-
cific behavior that DAZ Studio will exhibit when you load the file.  Green in-
dicates that something will be loaded into the scene by the file, for example 
an actor, wardrobe, a prop, etc.  Yellow indicates that the file will modify an existing object within the 
scene.  In order for files with yellow indicators to load, an object must be selected within the scene.  
Pose Presets and Material(s) Presets are two content types you will commonly see with yellow 
indicators.  Blue signifies that the content file will either cause an object to be loaded into the scene 
or modify an existing object in the scene based on the current scene selection.  A good example of 
this would be a Character Preset.  A red indicator means that the file will replace all existing instanc-
es with the same content type as the file in the scene.  For example, a Light(s) Preset will replace 
all existing lights in the scene.  A Scene file will cause the entire contents of the current scene to be 
replaced.  The last color you might encounter is magenta.  Ideally you will never encounter this color 
as it indicates that the file has been assigned a content type that is too generic to be of practical use.

Note: Hold the Ctrl/Cmd when loading DSON format content (content with a .duf file extension) to 
cause a dialog to appear that provides extended control over loading behavior.

Section 2.3 – Making a Selection 
and the Scene Pane
 Using the Scene pane to make a selec-
tion was covered briefly in Section 1.5.3.  How-
ever, there are few more details about the Scene 
pane that should be covered.  Figures are often 
organized in a hierarchy.  Not only can you select 
the top level of a figure (also referred to as the 
“root node,” “root” or “skeleton”), but you can 
select any level of the hierarchy (also referred to 
as a “node” or “bone”).  This allows you to select 
a whole item (such as a person), or just elements 
of the item (such as a hand, foot, or finger).

2.3.1 Expanding and Collapsing
 To quickly display all elements of all of your items in the Scene pane, simply right click within 
the pane and hover your cursor over the ‘Expand’ submenu.  You can then choose the ‘Expand All’ 
action.  This will expand all of the hierarchies present in the Scene pane.  Conversely, if you would 
like to tidy things up you can right click within the pane, hover your cursor over the ‘Collapse’ sub-
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menu and choose the ‘Collapse All’ action.  Remember ev-
ery element of a hierarchy is selectable.  Use the ‘Expand’ 
and ‘Collapse’ actions to quickly gain access to any level of 
a hierarchy.

 As discussed in Section 1.5.3, items in the Scene pane 
can also be expanded individually.  To expand or collapse 
any item in the Scene pane simply click the arrow to the left 
of the item.  You can also use the arrow keys on your key-
board to navigate and expand/collapse items in the Scene 
pane; left collapses, right expands, up and down changes 
the scene selection.

2.3.2 – Parenting
 The Scene pane can also be used to create a 
parent/child relationship between two figures or ob-
jects.  The parent/child relationship in DAZ Studio can 
be compared to the parent/child relationship in real 
life – which is to say, complicated.  One way to think 
of it is that wherever the parent goes, the child fol-
lows.  In DAZ Studio though, if the child object moves, 
the parent object doesn’t move with it.

 Parenting is useful for things like props and 
environments.  It allows you to group objects together 
so that when the parent object is moved, scaled, or 
rotated the child objects move, scale or rotate with it.  
It is also useful for organizational purposes by allow-
ing you to group objects in your scene.

 To parent an object to another object in the Scene pane, click on the intended child object and 
drag it over the intended parent object.  A colored box will surround the parent object, at which point 
you can let go of the button to drop the child onto the parent.  If you are parenting a prop like a staff 
to human Figure, make sure you parent it to the proper body part of the figure, for example the hand.

Section 2.4 – Scene Navigation
 Controlling the view in your scene is essential to being able to set up your scene the way you 
want it.  The reason this medium is referred to as “3D” is because your scene exists in three dimen-
sions; you as the director are able to view your scene in three dimensions - height, width and depth.  
DAZ Studio offers several controls to manipulate your view of the scene.  The purpose of this is 
twofold.  The first, to give you multiple views and angles of the scene to ensure things are set up just 
right.  The second is to help you frame your shot for the final render.  We’ll talk more about the latter 
in Chapter 6, for now we’ll focus on the first..
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 In DAZ Studio the “Viewport 
Controls” are located in the top right 
corner of the viewport.  In this corner 
you have several controls for manipu-
lating your view of the scene.  Starting 
from the top, moving right and then 
down, the viewport controls are:

• View Selection

• DrawStyle Options

• Viewport Options

• View: Orbit / Rotate / Bank

• View: Pan / Dolly

• View: Dolly Zoom / Focal Zoom

• View: Frame / Aim

• View: Reset

• The Camera Cube

 Several of these controls, as you can see, have multiple functions which will be covered be-
low.  If you ever forget what one of the controls does, simply hover your cursor over the control and a 
tooltip will appear to remind you.

2.4.1 The View Selection Menu
 DAZ Studio supports multiple cameras.  It also 
includes several orthographic views and one ‘Perspective 
View’ which functions as a Director’s Viewfinder.  You can 
use the “View Selection Menu” to switch between views, 
cameras, or even directional lights.  The name displayed 
on the view selection menu while closed is the name of the 
active view, camera or light.  “Chapter 6 – Cameras and 
Views” will cover these views in more detail.

Note: For the purposes of this chapter Perspective View 
should be chosen.
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2.4.2 – DrawStyle Options Menu
 “DrawStyle” refers to how DAZ Studio displays the scene 
preview in your viewport.  Remember that what you see while 
working on a scene is just a preview.  When rendered the final 
image will often look much more detailed.  While you are work-
ing, DAZ Studio displays a lower quality preview to conserve re-
sources and improve responsiveness.  Changing the DrawStyle 
will change how the preview appears.

 There are several options available, including ‘Wire 
Bounding Box’, ‘Solid Bounding Box’, ‘Wireframe’, ‘Texture 
Shaded’ and ‘Cartoon Shaded’.  Click the “DrawStyle Options 
Menu” to see all of the options available.  The default option is 
‘Texture Shaded’; this provides the most detail in preview and is 
the DrawStyle that most users prefer.  Feel free to change the 
DrawStyle and try out the various options.  If you don’t find any-
thing you like you can change it back to ‘Texture Shaded.’  Below 
you will find examples of the ‘Texture Shaded’ and ‘Wire Shaded’ 
DrawStyles.
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2.4.3 – The Viewport Options Menu
 The “Viewport Options Menu” gives you the abil-
ity to further customize the viewport.  You have options 
to dock or float the viewport controls (by default they are 
floating).  You can hide or show the “Floor Grid” and “As-
pect Frame” as well as the “Camera Cube.”  The most 
used action in this menu is the ‘Change Background 
Color….’ action.

 Choose the ‘Change Background Color...’ action 
to bring up the ‘Select Color’ dialog.  From here you 
can choose any color in the RGB spectrum.  By default 
the background color in the Hollywood Blvd layout is a 
light blue with an RGB value of 121, 141, 176, but you 
can choose any color you like.  You may find that a nice 
shade of gray is easier on the eyes - such as an RGB 
value of 94, 94, 94.  Each interface layout has its own 
background color, so if you switch layouts your back-
ground color may change.

2.4.4 – The View: Orbit Tool / Rotate / Bank Control
 The lower five icons on the right hand side of the viewport are all viewport controls.  The 
“View: Orbit / Rotate / Bank Control” allows you to adjust the rotation of the active view.  By left 
clicking and dragging, the view will “orbit” around the focal point of your view.  If you haven’t framed 
anything the view will orbit around a point on the positive Y axis, at the center of the scene.

Note: We will cover framing a selection in Section 2.4.7

 The control can also rotate the view about (around) an axis.  To do this, right click and drag.  
Dragging left and right will cause the view to pivot left or right along a vertical axis.  Dragging up or 
down will cause the view to pivot up and down along a horizontal axis.  The change in view is similar 
to moving your head left to right or up and down.

 The same control can also be used to “bank” the view.  To do this,  simply hold the Ctrl button 
on Windows or the Cmd button on the Mac and right click.  Dragging to the left will case the view to 
roll or bank to the right.  Dragging to the right will cause the view to bank to the left.

 Go ahead and play around with the control.  Try orbiting, rotating or banking your view.   Once 
you get a handle on the controls feel free to move on to the next section.  You can use the “View: 
Reset Control” to reset the position and rotation of the view to its default.

Note: The reset control is covered in Section 2.4.8
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2.4.5 – The View: Pan / Dolly Control
 The “View: Pan / Dolly Control” allows you to adjust the position of the view in three dimen-
sional space.  The control can move the view left/right and up/down in the plane parallel to your view; 
this is called panning.  You can also use the control to move the view left/right and in/out in a plane 
parallel to the floor; this is called dollying.

 To “Pan” the view, click the control and drag it.  The controls are inverted, which means if you 
drag to the left the view moves right – up and the view moves down.  This may sound counter-intui-
tive, but once you try it out you will find that it feels natural.

 To “Dolly” the view, right click the control and drag the control.  Once again the controls are 
inverted.  Drag to the left and the view moves to the right; drag forward and the view moves back-
wards.  Just like panning the inversion might sound counter-intuitive on paper, but it feels natural 
when you try it out.

 Feel free to take a few minutes to play around with the control.  You may even want to com-
bine use of the control with the orbit / rotate / bank control.  Play around until you are familiar with 
these controls.

Note: The orbit / rotate / bank control is covered in Section 2.4.4

2.4.6 – The View: Dolly Zoom / Focal Zoom Control
 The “View: Dolly Zoom / Focal Zoom Control” allows you to zoom in and out.  Zooming in 
moves the object closer to the view while zooming out moves the object farther.  However, zoom-
ing isn’t as simple as making things just appear larger or smaller in the viewport.  The dolly zoom / 
focal zoom control in DAZ Studio gives you two distinct options for zooming – Dolly Zoom and Focal 
Zoom.

 “Dolly Zoom” refers to zooming based on the movement of the view in three dimensional 
space.  When a dolly zoom is performed, the entire view either moves closer or farther from the 
object.  To dolly zoom the view, left click on the control and drag.  Dragging backward will zoom in; 
dragging forward will zoom out.  You can also perform a dolly zoom by using your scroll wheel (if you 
have one).  Scroll forward to zoom out or “push” the objects in the scene away from you, and scroll 
backward to zoom in or “pull” the objects in the scene toward you.

 “Focal Zoom” refers to the zoom function of a camera lens.  When a focal zoom is performed 
the position of the view remains stationary.  The zooming comes from the change in the lens.  In DAZ 
Studio the ability to perform a focal zoom is actually much greater than on most physical cameras.  
You can zoom extremely far in or out.  Keep in mind that extreme focal zoom will cause distortion 
- which can be an interesting effect, if that is your goal.  To perform a focal zoom, right click on the 
control and drag.  Dragging up will zoom out while dragging the downwards zooms in.

 The focus of a zoom will be the focal point of your view.  If there is no framed selection then 
the focus of the zoom will be a point on the positive Y axis, at the center of the scene.  Framing a 
selection will be covered more in depth in Section 2.4.7.
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 Take some time to play around with the control and familiarize yourself with the two types of 
zooming.  You will be able to see the different effect that each type of zoom has on your scene.  If 
you feel bold you can combine the control with the other tools you have learned about.

2.4.7 – The View: Frame / Aim Control
 The “View: Frame / Aim Control” is an extremely handy control used to “jump to” or “target” 
an item with the view.  When activated, the frame / aim control will frame and/or aim at your current 
scene selection.  Orbiting, rotation and banking for the view will remain the same when this control 
is used, the only thing that will change for the view is the pan and zoom.  DAZ Studio will automati-
cally pan and zoom the camera to center and focus your selection in the viewport.  This is extremely 
convenient when you have large environments and multiple items in a scene.  It allows you to quickly 
shift your view to any item in the scene.

 To “Frame” an item in your scene, first ensure that you have the desired item selected in the 
Scene pane.  Once the selection has been made left click on the control.  The active view will snap to 
position and frame your current selection.

 If you right click the control the pan and zoom for the view will remain static.  Instead of mov-
ing to frame the selection, the view will remain in its current location and rotate to frame the selection.  
This allows you to retain your current view position and still frame the object.  This is said to “Aim” the 
view.

 Framing has a secondary effect in that the “Focal Point” for the view will be placed at the cen-
ter of the bounding box for the current selection.  This will affect how the orbit / rotate / bank control 
and the dolly zoom / focal zoom control work, since these two controls function based on the focal 
point of the view.

2.4.8 – The View: Reset Control
 The “View: Reset Control” will set all values for the view including dolly, zoom, pan, and bank 
back to their defaults.  This function is very useful if you have banked or rotated the view in an unde-
sirable manner and you wish to ‘right’ the view.

2.4.9 – The Camera Cube
 The “Camera Cube” is the tri-colored cube that resides just to the left 
of  the other viewport controls.  It allows you to orbit the view around the 
focal point of your view and functions similar to the orbit / rotate / bank 
control.  In fact you may have noticed when you used the orbit / rotate 
/ bank control, that the cube moved as you orbited or rotated the view.  
The primary benefit of the cube is that it provides you with frame of 
reference while orbiting or rotating the view.  You can see based on the 
cube which direction the view is currently pointed.  To use the cube, left 
click anywhere on the cube and drag.
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 In addition to dragging the cube to orbit the view you can also use 
“Vantage Points” on the cube to “jump to” a predefined position.  As you hover 
your cursor over the cube you may notice that certain sections of the cube 
become highlighted.  These are the vantage points and they are located at 
each of the faces, corners and edges of the cube.  If you left click while a 
vantage point is highlighted, the view will automatically orbit to that relative 
position.  This allows you to quickly move to certain views such as front, back, 
left, right, top, bottom, or any combination thereof.

Section 2.5 – Modifying Content in the Parameters Pane and Viewport
 Now that you have content loaded into the scene, you know how to select and parent it within 
the Scene pane, and you know how to control the view to explore your scene let’s focus on modifying 
the content you have loaded.  To do this we will be taking a closer look at the Parameters pane.

 With the Parameters pane you will be able to translate, 
rotate and scale your figures or objects.  The Parameters 
pane can also provide you with additional ways to modi-
fy objects in your scene.  Each option in the Parameters 
pane is known as a “Property” or “Parameter” - the terms 
are used interchangeably.  Properties exist within “Proper-
ty Groups” which serve to organize properties into smaller 
collections to help users locate and explore the properties 
available for an object.  In the Parameters pane you will see 
property groups listed on the left and individual properties 
listed on the right.  We will go over how to use the properties 
in the ‘Transforms’ group to translate, rotate and scale your 
object as well as a few other important properties found in 
the Parameters pane.

 In order for the properties of an object to show up in the Parameters pane the object must first 
be selected in the Scene pane.  The available properties may change depending on the object that is 
selected, or the node of the figure that is selected.  Try selecting different nodes in the scene to see 
how it affects the available properties in the Parameters pane.

Note: For more information about the Parameters Pane see Section 1.5.4
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2.5.1 – Translation
 “Translation” refers to the positioning of the figure 
along the X, Y and Z axes.  The translation properties 
in the Parameters pane can be found by expanding the 
‘General’ group in the left column of the pane.  Under 
the ‘General’ group you will find the ‘Transforms’ group.  
Expanding the ‘Transforms’ group will reveal the transfor-
mation groups available for the current scene selection.  If 
translation properties are available for your selection then 
you will see the ‘Translation’ group listed under the ‘Trans-
forms’ group.  When you click on the ‘Translation’ group in 
the left column the translation properties will appear in the 
right column.

 You can translate your object in any direction by adjusting the appropri-
ate slider.  For ease of use, each axis in DAZ Studio is color coded.  Red 
indicates the X-axis, green represents the Y-axis and blue the Z-axis.  Play 
around with the translation properties for your selection to get a feeling 
for how the object moves when you adjust the sliders.  You may want to 
change your selection in the Scene pane and practice translating other 
items in your scene.

 Translation can also be accomplished in the viewport using the 
“Universal Tool.”  To translate an object in from within the viewport first 
activate the Universal Tool in the toolbar.  Make sure you have your 
desired object selected in the Scene pane - you can also make your 
selection by left clicking on an object in the viewport.  Once an object is 
selected the “Universal Manipulator” will be displayed next to the se-
lection.  The red, green and blue arrows at the ends of the X, Y and Z 
axes on the manipulator can be used to translate the object.  Left click 
any of the arrows and drag the object to translate it on the chosen axis.  
You can also translate the object within a plane created by two adjacent 
axes, by left clicking the triangle in the outside corner of that plane on 
the manipulator and dragging.
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2.5.2 – Rotation
 Not only can you use the rotation properties to rotate 
an entire Figure, but you can also use them to rotate a single 
bone.  The current scene selection is very important when 
using the rotate properties, so be aware of your current scene 
selection when rotating.

 The rotation properties are located in ‘Rotation’ prop-
erty group in the Parameters pane.  The ‘Rotation’ group 
resides within in the ‘Transforms’ group, which is under the 
‘General’ group.   Left click the ‘Rotation’ group to display the 
available rotation properties for your current selection.  Just 
like the translation properties, the rotation properties are color 
coded.  Red indicates rotation about (around) the X-axis, 
green the Y-axis, and blue the Z-axis.

 Play around with the different rotation properties to get a feel for how your figure acts when 
rotated.  To see the real power,  you should not only rotate the root node of a figure, but try rotating 
some of the bones.  If you still have Genesis 2 Female in your scene, try rotating the thighs and 
shins, as well as the head, neck, and forearms.  You will see how the rotation properties can quickly 
become a powerful tool for posing and positioning your figure.

 Rotation can also be accomplished in the viewport through use of the Universal Tool.  Activate 
the tool from within the toolbar.  Once the tool is activated make your selection in the Scene pane, or 
by left clicking your selection in the viewport.  Once a selection is made you will see the manipulator 
in the viewport.  Use the red, green and blue arcs to rotate the object.  Hover your cursor over one 
of the arcs until it is highlighted yellow and a full circle appears.  You can then left click and drag to 
rotate the figure or node around the chosen axis.

2.5.3 – Scale
 “Scale” is involved in modifying the relative size of 
objects in your scene.  You can make any object in your scene 
larger or smaller by changing its scale.  Most objects will allow 
you to scale the entire object as well as along the individual X, 
Y and Z axes.  Be careful when scaling objects as it can lead 
to distortions on an object or figure.

 To access the scale properties for an object open the 
Parameters pane and look within the ‘General’ group, to the 
‘Transforms’ group.  You will see the ‘Scale’ group nested 
inside of the ‘Transforms’ group.  Left click on the ‘Scale’ group 
to display all of the scaling properties available.  Depending on 
your current selection you may or may not have scale property 
available.  If you don’t see scaling options try changing your 
selection to the root node of the figure.
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 You can adjust the sliders for each of the scale properties to scale the figure on the X, Y or Z 
axis.  You also have the option to scale the entire figure uniformly.  Just like the translation and rota-
tion properties, the scale properties are color coded bases on the axis they affect - red for the X-axis, 
green for the Y-axis and blue for the Z.

Note: Not every selection will have scaling available in the X, Y and Z axes.

 Scaling can also be done in the viewport with the aid of the Universal Tool.  To scale an item 
in the viewport, activate the Universal Tool in the toolbar.  Next, select the item you would like to 
scale in the Scene pane - you can also make the selection by left clicking the object within the view-
port.  Finally, use the white cube at the center of the Universal Manipulator, or the red, green or blue 
cubes on the X, Y or Z axes to scale the selection.  Simply left click on one of the cubes and drag to 
affect scale.

2.5.4 – Fit to (aka Conforming)
 When you load clothing or hair onto a figure, you want 
that clothing or hair to move when your figure moves.  If you bend 
the arm of your figure, you want the shirt the figure is wearing to 
follow suit.  DAZ Studio does this through a process referred to 
as “Fitting” or “Conforming.”  Most clothing and hair is set up so 
that when it is fit to a figure it will follow that figure, mimicking it in 
every way that it can.

 When you load clothing and hair into a scene it should 
automatically fit to your figure if that figure is selected when the 
clothing or hair is loaded.  If for some reason the clothing or hair 
did not conform automatically, you can use the Parameters pane to fit the clothing to the desired 
figure.

 The first step is to make sure that the clothing item is the cur-
rent scene selection.  You can do this by selecting the clothing item 
in the Scene pane.  Once it is selected open the Parameters pane 
and look in the ‘General’ group.  In the ‘General’ group you will see 
the ‘Misc’ group.  The property for fitting a clothing item is in the 
‘Misc’ group and is labeled ‘Fit to.’  If the clothing is not fit to any-
thing, ‘None...’ will be displayed as its value.  To change this click on 
the current value of the property.  This will launch the ‘Fit To’ dialog 
where you can choose a figure to fit the clothing to from the drop 
down menu.

 Clothing and hair are meant to fit specific figures.  When you load clothing for a figure from 
the Smart Content pane only clothing designed for the figure is displayed.  However, it is possible 
to load clothing designed for one figure, and use the ‘Fit To’ property to fit it to another figure - with 
varied results.  This is done using the “Auto-Fit” action.  Not every clothing item can be auto-fit to a 
figure, however it never hurts to try; with some tweaking you may be surprised at what clothes will 
auto-fit.
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2.5.5 – Other Properties in the Parameters Pane
 You probably noticed that there are other property groups besides those we just covered in 
the Parameters pane.  We will cover most of these groups in later chapters.  However, it is beneficial 
to give a brief overview of each of the groups here:

• General

• Actor

• Display

• Pose Controls

 The ‘General’ group houses the ‘Transforms’ group that was discussed above.  It also con-
tains properties that allow you to adjust the smoothing and resolution of your mesh.

 The ‘Actor’ group contains shaping properties or morphs.  “Morphs” allow you to change the 
shape of your figure.  We will discuss morphing and shaping in Chapter 4.  Any property that shows 
up in the ‘Actor’ group will also be available in the Shaping pane.

 The ‘Display’ group allows you to adjust various display related aspects of your object or Fig-
ure.  You can change whether or not the object or figure is visible in the final render, whether or not 
shadows the object casts a shadow, as well as other options.
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 The ‘Pose Controls’ group contains properties that allow you to pose your figure.  These prop-
erties will control a specific movement of the figure such as raising or lowering the arms, or opening 
and closing the mouth.  Any property in the ‘Pose Controls’ group will also appear in the Posing 
pane.

Section 2.6 − Saving and Loading a Scene
 When you’ve spent hours setting up and organizing the 
perfect scene you will want to save that hard work.  DAZ Studio 
provides several ways to save your work, the most basic of these 
is saving a “Scene” file.  When you save a scene file, information 
for everything in your scene - actors, wardrobe, props, lights, 
cameras etc. are all saved.  When you open the scene file, ev-
erything will load just as it was when you saved your scene.

 To save a scene file in DAZ Studio use the File→ Save… 
action.  You can also use the hotkey Ctrl+S on a PC or Cmd+S 
on a Mac.  This action will open the ‘Filtered Save’ dialog where 
you can name your scene file and choose a save location.  Take 
note of where you are saving your scene so you can find it later.  
Once you have chosen a name and save location click save and 
DAZ Studio will save your file.  Depending on the size of your 
scene and the speed of your machine this can take anywhere 
between a few seconds to several minutes.

 You can load a previously saved scene file by going to File→ Open..., or using the hotkey 
Ctrl/Cmd+O.  This action will launch the ‘Open File’ dialog where you can browse to your saved 
scene file.  Once you have found your scene in the file browser highlight the file by clicking on it and 
then click open.  Opening a scene file will replace everything in your current scene, so make sure 
you save your work before opening a new scene file.  If you use File→ Merge… or Ctrl/Cmd+Shift+O 
the scene file will be merged with your existing scene rather than replace it.
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Section 2.7 – Wrap-Up
 We will go over rendering in finer detail in Chapter 
8.  However, since you’ve worked so hard playing around 
and building this scene it would be a pity not to render it.  To 
render your scene using the current render settings open the 
‘Render’ menu in the main menu bar and choose the ‘Ren-
der’ action.  Alternatively you can use the hotkey Ctrl+R on a 
PC or Cmd+R on a Mac.  This will start the rendering pro-
cess.  Your final render will appear in a new window.
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Textures, Surfaces and Materials
The Wonderful World of Color

Section 3.1 – Introduction
 In many 3D applications, when a model is created, by de-
fault that model will be a single color - usually gray.  A real world 
analog to this would be sculpting in clay.  When a clay sculpture 
is created the color of the sculpture is the color of the clay.  It is 
only after the artist paints or glazes the sculpture that it takes on 
a unique color.  The same is true when modeling in 3D; the 3D 
“clay” is a single color determined by the modelling application.  
Instead of painting directly on to the model in DAZ Studio we 
apply “Textures” or “Image Maps” to give the model color.

Note: Most models purchased from DAZ 3D will load with a 
texture applied to them.  That doesn’t mean you won’t be able to 
customize the surface.

 Chapter 3 is devoted entirely to the surface of your model.  We will go over the tools available 
in DAZ Studio which allow you to change your object from its default gray state to something more 
interesting.  The possibilities are endless; you can focus on hyper-realism and try to get your surfac-
es to mimic those in the real world as closely as possible, you can stylize your surfaces giving your 
render a cartoon look and feel, or you might choose something somewhere in between.  With DAZ 
Studio the power is in your hands.

Section 3.2 – Surfaces
 Before we jump into the process of applying textures to your 
figure there are a few concepts we will cover as a foundation.  
We’ll cover these in the next few sections.  The first concept to 
understand - what a “Surface” is.  It isn’t a terribly difficult concept 
to master, and you don’t need a vast knowledge of the subject to 
be successful in DAZ Studio.

 A “Surface” is a specific subsection of the 3D model, a group 
of specific polygons, that share common properties to describe 
what the surface of the model looks like.  When an artist models 
an object, he or she will assign specific sections of the model to 
a named surface.  When they are finished, every polygon of the 
model will be assigned to one surface or another.  A simple model 

may have only one surface, while a complex model can have multiple surfaces.  The Genesis figure, 
for example, has 26 surfaces.

Note: You can view a complete list of a model’s surfaces in the Surfaces pane.  More on this in Sec-
tion 3.5.
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 The concept may be easier to visualize with an example.  Imagine you have modeled a jack-
et.  Most jackets will have buttons, zippers, buckles, rivets, etc as well as the cloth material for the 
jacket.  Each of these parts of the jacket is different, and look different.  A 3D modeler would be wise 
to assign the buttons to their own surface, the zipper to its own, etc.  This allows the user to custom-
ize the look of each part individually.  In this scenario a user would be able to give the cloth a matte 
look, while making the buttons and buckle shiny.  In DAZ Studio the user can customize each surface 
individually rather than having the settings apply to the surface of the entire model.

Section 3.3 – Image Maps
 Now that you know what a surface 
is, the next logical concept to introduce is 
image maps.  An “Image Map” is a 2 dimen-
sional image that “wraps” around a surface.  
The majority of surfacing is done with im-
age maps.  They provide the easiest way to 
get results that don’t look uniform across a 
surface (e.g. skin with freckles).  Essentially, 
they add detail to the surface of the model.

Note: Image maps are occasionally referred 
to as “Texture Maps”, especially when de-
signed to be used in the ‘Diffuse Color’ prop-
erty.  See Section 3.5.1 below.

 Image maps can serve a variety of 
purposes, and we will discuss those more in 
Sections  3.4 and 3.5.  For now, however, just 
think of an image map as the wrapping paper 
for your model.

 The way the image map wraps around the model is determined by a “UV Set” - a set of 2 
dimensional coordinates that correspond to 3 dimensional point on a model.  The intricacies of UV 
mapping won’t be covered in this guide.  However, DAZ Studio allows multiple UV sets for a figure.  
We will cover changing the UV set of a figure in Section 3.5.8.

 Above you’ll find an example of image maps for the ‘Face’ and ‘Torso’ of Genesis as well as 
an example of those image maps applied to the model.  Hopefully this will help you visualize how 2 
dimensional image maps work in 3 dimensional space.

Section 3.4 – Surface Shaders
 The last foundational concept we need to cover before getting into the meat of this chapter 
is that of a “Surface Shader.”  The concept of a surface shader is a little more abstract than that of 
a surface, or an image map.  The reason being that you can’t really see a surface shader in your 
scene, you can only see the results of one.  The simplest way to describe a surface shader is to say 
that it is a program that is run, by the “Render Engine”, for every visible/sampled point on a surface in 
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order to describe what the final color and opacity of that surface should be.  It calculates how a sur-
face reacts to light, how or whether it reflects, or refracts etc.  A surface shader ultimately determines 
the RGB value for every pixel in the scene.

 If we take this a step further, we can say that a surface shader is a “Shader” that is specif-
ic to a surface or multiple surfaces.  In DAZ Studio there are 5 different types of shaders including 
Surface, Light, Volume, Imager and Displacement – with [custom] surface shaders being the most 
common.  For the scope of this User Guide, we will only cover surface shaders.  Other shaders are 
covered in online documentation.

 Fortunately, as complex a topic as shaders are, DAZ Studio comes with several ready-made 
shaders so that you don’t need to worry about creating or writing your own -  we’ll leave that to those 
with advanced degrees in computer science and physics.  All you need to know is that the surface 
shader that is applied to a surface determines what properties are available for that particular surface 
in the Surfaces pane.  We’ll cover how to find out what surface shader you are using later on in this 
section.

 The most common type of custom shader is a surface shader - custom meaning it is not a 
DAZ Studio default shader.  You may encounter instances where people will refer to a surface shad-
er simply as a shader.  As discussed previously there are different types of shaders.  While this isn’t 
incorrect (a surface shader is one type of shader), it is good practice to include the type of shader 
when referring to it.  You may also encounter instances where people refer to a “Shader Preset” as a 
shader - this is incorrect.

Note: The 3Delight render of a surface with a custom surface shader applied may be dramatically 
different than the “Viewport” preview.

Section 3.5 – The Surfaces Pane
 So far in this chapter we’ve covered surfaces, im-
age maps and surface shaders - all to prepare you to use 
the Surfaces pane.  The Surfaces pane is where you will 
customize the surfaces of your objects in DAZ Studio.  In 
the Hollywood Blvd layout, the Surfaces pane is located on 
the left hand side of the interface, in the ‘Actors, Wardrobe 
& Props’ activity.

 The Surfaces pane is divided into three “Pages.”  
You can access each of these pages at the top of the 
pane.  They are the Presets page, the Editor page and the 
Shader Baker page.  We are going to focus on the Editor 
page in this section.  If the Editor page isn’t selected, go 
ahead and click on the ‘Editor’ label at the top of the pane 
to bring the Editor page forward.
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 The Editor page of the Surfaces pane is organized similarly to the Parameters pane.  On the 
left hand side you will see your current scene selection, as well as any items associated with the 
current scene selection such as clothing, hair or props.  You can expand any of the objects in this list 
to reveal their surfaces.

Note: The current scene selection must have geometry in order for it to show up in the Surfaces pane 
Editor page.  Objects without geometry such as “Lights” and “Cameras” won’t show up in the Surfac-
es pane.

 If you still have the Genesis 2 Female figure loaded in the scene you should see it listed in 
the Surfaces pane on the left hand side.  If Genesis 2 Female isn’t in the scene go ahead and load 
her into the scene now.  If you still don’t see her in the Surfaces pane check the Scene pane to make 
sure that Genesis 2 Female is your current scene selection.

Note: For instructions on how to load content into the scene see Section 1.5.1.

 Now that Genesis 2 Female is in your scene and you have her selected you should see her 
in the Surfaces pane on the left.  Click the arrow next to Genesis 2 Female to reveal her surface 
selection sets and her surfaces.  A “Surface Selection Set” is just a predetermined group of surfac-
es.  They allow you to edit surfaces that are commonly edited together, such as the face head and 
lips, without having to select the individual surfaces yourself.  Genesis 2 Female has several surface 
selection sets.  You can browse through them by clicking the arrows next to ‘Default Templates’ or 
‘Legacy Surfaces.’

 Clicking the arrow next to ‘Surfaces’ will reveal all of the surfaces for Genesis 2 Female.  This 
is where you can select individual surfaces to edit.  To select a surface, simply left click on the sur-
face.  You can select multiple surfaces at the same time by holding the Ctrl key and left clicking on 
the PC, or holding the Cmd key and left clicking on the Mac.

 The left column of the Surfaces pane also gives 
you the option to display all properties in the right hand 
column.  To do this left click on the ‘All’ “Filter.”  You can 
also choose to display only properties that are currently 
in use.  To do this left click on the ‘Currently Used’ filter.

 When you select a surface, surfaces, a surface selection set, surface selection sets, or an 
entire object you will see the properties associated with these surfaces on the right hand side of the 
pane.  Remember, from our discussion about surface shaders (Section 3.4), that it is the shader that 
determines which properties are available for the selected surfaces.  The shader that is applied to 
the current selection will be listed at the top of the Surfaces pane.  The ‘DAZ Studio Default’ surface 
shader is the most common as it is the default surface shader for DAZ Studio, but you will also see 
the ‘omUberSurface’, the ‘AoA_SubSurface’ and other custom surface shaders on occasion.
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 Regardless of the surface shader that is applied to the surface there are a few properties that 
are fairly common among a majority of surface shaders.  They are:

• Diffuse Color and Strength

• Specular Color and Strength

• Glossiness

• Ambient Color and Strength

• Opacity Strength

• Bump Strength

• Displacement Strength
The following sections will briefly describe each of these properties and what they do.

3.5.1 – Diffuse Color and Strength
Diffuse Color
 In the real world, the surface of an object absorbs 
certain wavelengths of light and reflects others.  The col-
or we see is determined by the wavelength of light that is 
reflected by the surface of the object.  A diffuse reflection 
is scattered, meaning a beam of light hitting the surface is 
reflected simultaneously in multiple directions.  The “Dif-
fuse Color” of an object represents this scattered, diffused, 
reflection of light.  The simplest explanation for diffuse color 
is that it is what we perceive as the [matte] color of the sur-
face.

 There are a couple of ways you can define the diffuse color of a surface in DAZ Studio.  The 
simplest way is to change the RGB color value using the ‘Diffuse Color’ property.  This will affect the 
entire surface uniformly.  To change the RGB value you can left click and drag any of the numbers.  
You can also left click directly on the color, between the numbers, to open the ‘Select Color’ dialog.  
This dialog allows you to pick a color from a color palette.

 The second way to edit the diffuse color of a surface is to load an 
image map - sometimes referred to as a “Texture Map.”  If you have an 
image map that matches with the current UV set for the surface, you 
can load it by clicking the “Image Menu Button” on the ‘Diffuse Color’ 
property.  The image menu button is on the left side of the property and 
is decorated with a downward pointing arrow.  Clicking the image menu 
button will open a drop down menu with a list of recently used textures 
as well as a few other actions.  Click ‘Browse...’ to open a Windows 
Explorer window or an OS X Finder window that will allow you to browse 
your hard drive for the desired image map.  Image maps allow for a 
more realistic look because they allow you to have more than just a 
single color applied across the entire surface.
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Diffuse Strength
 “Diffuse Strength” determines the amount 
to which the diffuse color contributes to the overall 
appearance of the surface.  You can think of it as 
the percentage of light that is reflected by the sur-
face.  When the ‘Diffuse Strength’ property is set 
to a value of 0%, all light hitting the surface will be 
absorbed and the surface will appear black.  When 
the ‘Diffuse Strength’ property is set to a value 
of 100% all light with a wavelength matching the 
diffuse color will be reflected, giving the color full 
strength.

 The ‘Diffuse Strength’ property can be controlled in two ways.  The first is through the slider.  
This will affect the entire surface uniformly.  You can adjust the slider to a value anywhere between 
0% and 100%.  As with the ‘Diffuse Color’ property, you can also add an image map to the ‘Diffuse 
Strength’ property.  The difference is that a diffuse strength image map will be a grayscale image.  
Pixels in the image that are white correspond to a 100% value.  Pixels in the image that are black 
correspond with a 0% value.  Gray values fall somewhere between; the darker the gray the lower the 
value.  Using a grayscale image map allows you to vary the value across a surface.  The image map 
can be loaded using the ‘Diffuse Strength’ property’s image menu button.  When an image map is ap-
plied, the value of the ‘Diffuse Strength’ slider acts as a multiplier for the value in the map.

3.5.2 – Specular Color and Strength
Specular Color

 When a beam of light hits a surface and is 
reflected in a single direction that reflection is referred 
to as a specular reflection.  In DAZ Studio, “Specular 
Color” refers to the highlights caused by this direct 
reflection of light.  This property isn’t used to create a 
mirror like effect.  It merely represents the color of the 
highlight on the surface.  You can change the ‘Specu-

lar Color’ property in the same way that you can change the ‘Diffuse Color’ property – with either an 
image map, or with the RGB value for the surface.

Specular Strength
 “Specular Strength” is similar to diffuse strength 
in that it represents the percentage of light that is 
reflected from the surface.  In this instance however, 
it only applies to specular reflections.  At a value of 
0%, there is no specular reflection, and thus no high-
lights.  At a value of 100%, the specular value is at full 
strength and all light that matches the wavelength of 
the specular color is reflected directly from the surface.  
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The ‘Specular Strength’ property can be adjusted in the same manner as the ‘Diffuse Strength’ prop-
erty.  When an image map is applied, the value of the ‘Specular Strength’ slider acts as a multiplier 
for the value in the map.

3.5.3 – Glossiness
 “Glossiness” determines the size of the specular highlight on a surface.  The shinier, or more 
glossy, a surface is the smaller and sharper the specular highlight will be.  A surface with a low gloss-
iness value will have its specular highlight diffused across a larger surface area.  Glossiness does 
not affect how strong the highlight is (that is handled by the ‘Specular Strength’ property) just the size 
of the specular highlight.  However, larger specular highlights are perceived as being less intense 
since they are diffused across a larger surface area.  You can see examples of how the ‘Glossiness’ 
property affects the size of the specular highlight in the images below.

 The ‘Glossiness’ property can be manipulat-
ed just like the ‘Specular Strength’ property, or oth-
er strength properties.  You can adjust the slider to 
change the glossiness of the entire surface - the higher 
the glossiness value, the more concentrated the high-
light.  You can also apply a grayscale image map to the 
‘Glossiness’ property.  When an image map is applied, 
the value of the Glossiness slider acts as a multiplier 
for the value in the map.

3.5.4 – Ambient Color and Strength
Ambient Color
 In the real world, rays of light are constantly 
bouncing around.  Ambient light is the term used to 
describe the uniform effect that the bounced light has 
on a scene - instead of direct light that comes from 
a defined source.  DAZ Studio mimics this effect, but 
instead of providing a single point of control in the form of a light that affects all surfaces in the same 
way, DAZ Studio provides a more flexible means whereby each surface has its own controls that 
can be set independently to produce various effects.  It is the ambient light that affects the color and 
value of core shadows on a surface.  The ‘Ambient Color’ property determines the color of the core 
shadows created on a model’s surface as a result of the light in the scene.
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 By default the ‘Ambient Color’ property is set to an RGB value of 0, 0, 0 or black.  This mimics 
the way ambient light behaves in most real worlds settings.  However, changing the Ambient Color 
property can create some really cool effects, the most common of these would be to get a surface to 
“glow” in a low light area.  The surface isn’t actually glowing (it doesn’t emit light), but in a low light 
area it can appear to glow if the value of the ‘Ambient Color’ property is set to something lighter than 
the rest of the scene.

Ambient Strength
 “Ambient Strength” determines the amount of 
simulated ambient light that the surface will receive.  
Remember that the ambient light effect is not propagat-
ed to the rest of the scene.  The value of the ‘Ambient 
Strength’ property will only affect the surface(s) you have 
selected.  You can change ambient strength the same 
way you change diffuse or specular strength.  When an 
image map is applied to the property, the value of the 
slider acts as a multiplier for the value in the map.

3.5.5 – Opacity Strength
 “Opacity” refers to the transparency, or rather 
lack of transparency, of the object.  If you remember way 
back to primary school - transparent means completely 
see through, translucent is partially see through, and 
opaque isn’t see through at all.  When opacity is at 100% 
the surface is 100% opaque.  When opacity is at 0% 
the surface is 100% transparent or 0% opaque.  Values 
between 0% and 100% make the surface translucent.

 ‘Opacity Strength’ can be adjusted in a manner similar 
to the other strength values we’ve discussed.  You can use the 
slider of the ‘Opacity Strength’ property to affect the opacity of 
the entire surface.

 In many cases you will only want part of a surface to be 
transparent.  This is done using an opacity map.  An “Opacity 
Map” is a grayscale image map.  Black in the image corre-
sponds to an opacity value of 0%, and thus a fully transparent 
surface.  White corresponds with an opacity value of 100% 
and thus a fully opaque surface.  An opacity map allows you to 
clip out sections of your surface.  You can load an opacity map 
the same way you would load other image maps – with the im-
age menu button for the Opacity Strength property.  When an 
image map is applied, the value of the Opacity Strength slider 
acts as a multiplier for the value in the map.
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Note: Opacity maps are commonly referred to as transparency maps.  The term “Transparency 
Map” is a misnomer, as image maps are typically named according to the meaning of their full value.  
Technically speaking a transparency map would be the inverse of an opacity map.  However, the two 
terms are used interchangeably.

3.5.6 – Bump Strength
 When someone creates a 3D model, the sur-
face of the model is usually smooth.  In the real world 
however human skin, walls, and other surfaces are 
rarely perfectly smooth.  Human skin has pores and 
other imperfections, most walls have spackle or other 
texture to them.  “Bump” allows you to simulate these 
imperfections without actually changing the mesh of 
the object.

 DAZ Studio simulates these imperfections through a specific 
type of image map called a bump map.  A “Bump Map” is a gray-
scale image that indicates the strength of the bumps to be sim-
ulated.  By default an RGB value of 128, 128, 128 corresponds 
to a neutral bump.  Anything lighter indicates bump simulated 
in a positive direction, anything darker simulates a bump in the 
negative direction.  Once an image map is loaded for the ‘Bump 
Strength’ property a slider to adjust overall “Bump Strength” will 
become available.

 You can load a bump map using the image menu button for 
the ‘Bump Strength’ property.  When an image map is applied, 
the value of the ‘Bump Strength’ slider acts as a multiplier for the 
value in the map.  Most surface shaders will offer two addition-
al bump related properties labeled ‘Bump Minimum’ and ‘Bump 
Maximum.’  These values determine the simulated bump minima 
and maxima.  ‘Bump Minimum’ and ‘Bump Maximum’ can also 
shift or scale the values from a bump map.

Note: Bump will not be seen until the image is rendered.

3.5.7 – Displacement Strength
 “Displacement” is similar to bump in that it 
allows you to add details to the surface of the model 
without having to actually model the details in.  The 
difference is that bump is a simulated effect, while 
displacement actually changes the shape of the 
mesh.  To explain the difference, lets use an exam-
ple.  Think of a brick wall.  One might use bump to simulate the roughness on the surface of each 
brick.  To simulate the gaps caused by the mortar one would use displacement.
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 Just as with ‘Bump Strength’ you must load an image map to use the ‘Displacement Strength’ 
property.  An image map used for displacement is called a “Displacement Map.”  A displacement map 
is also a grayscale image and can be loaded using the ‘Displacement Strength’ property’s image 
menu button.  By default an RGB value of 128, 128, 128 indicates no displacement.  Anything lighter 
than this is considered positive displacement (i.e. the mesh will be displaced outwards) while any-
thing darker is negative displacement (i.e. the mesh will be displaced inwards).

 Some surface shaders will allow you to set 
the minimum and maximum values for displace-
ment.  This determines how far the displacement 
of the mesh will go when maximum values are 
reached.  The ‘Minimum Displacement’ value 
corresponds with negative displacement while 
‘Maximum Displacement’ corresponds with posi-
tive displacement.  The ‘Minimum Displacement’ 
and ‘Maximum Displacement’ properties can be 
used to shift or scale the values of a displacement 
map.

Note: 1 unit in DAZ Studio equals 1 centimeter.  Keep this in mind when setting minimum and maxi-
mum displacement values.

Note: You will not see the effects of displacement until the image is rendered.

3.5.8 – UV Set
 As explained in Section 3.3, a “UV Set” is a 
set of 2 dimensional coordinates that correspond 
to a 3 dimensional point on a model.  The UV set 
determines how a 2 dimensional image will “wrap” 
around the 3 dimensional model.  A good UV set 
will minimize stretching and compression while 
placing seams in logical or hidden locations of the 
model.

 Because the Genesis and Genesis 2 figures have incredible morphing capabilities, DAZ 
Studio allows for multiple UV sets.  If an artist creates an extreme morph for Genesis or one of the 
Genesis 2 figures they can include an additional UV set that will account for any distortions caused 
by the changes in the morph.  Support of multiple UV sets also increases texture compatibility across 
figures.

 The ‘UV Set’ property on a surface determines which UV set is used for that surface.  It is 
important that the UV set and image maps for a particular surface match.  If they don’t you are likely 
to get distortion and seams.
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 You can change the UV set for a single surface, for multiple surfaces, or (more commonly) for 
an entire figure.  To switch the UV set for your current selection in the Surfaces pane click the UV set 
selection list and choose a UV set from those that are listed.

Section 3.6 – Loading Material Presets
 Getting all of the settings right for each 
surface, loading image maps, setting values etc. 
can be tedious.  Most products you purchase 
from the DAZ 3D store will come with presets 
that set values and load image maps onto the 
properties that, together, describe the surface(s) 
of a figure or object - collectively referred to as a 
“Material.”  These presets are called “Material(s) 
Presets” and are by far the easiest way to set 
the properties for the surface(s) of your model.

 Material(s) Presets can be loaded 
through the Presets page of the Surfaces pane 
as well as through the Smart Content pane and 
the Content Library pane.  To access the Pre-
sets page first make sure the Surfaces pane is 
open.  At the top of the pane you will see all of its pages (Presets, Editor, and Shader Baker).  Click 
the ‘Presets’ label to bring the Presets page forward.

 The Presets page of the Surfaces pane is organized and functions very similarly to the Smart 
Content pane.  On the left hand side you have a list of categories, or the “Category View”, which can 
be expanded or collapsed.  On the right hand side, in the “Asset View”, you will find icons for each 
file in the selected category.  Remember, since the Preset page works like the Smart Content pane 
you must have a figure selected before you will see any of the presets.

 If you still have Genesis 2 Female in your scene make sure she is your current scene selec-
tion.  If she is not, select her in the Scene pane.  Once she is selected all of the Material(s) Presets 
available for her can be accessed.  By default she comes with several eye and make up options.  As 
well as one texture for the whole body named ‘Bree All.’  If you double click any of the icons it will 
load that Material(s) Preset on to the figure.  Feel free to try out some of the eye or make up options.  
If you use the ‘Bree All’ preset, it will restore the materials for Genesis 2 Female back to their original 
state.

 You can also load Material(s) Presets from the Smart Content pane and the Content Library 
pane.  Any Material(s) Preset available in the Smart Content pane will be available in the Presets 
page of the Surfaces pane.  Keep in mind that this type of preset must apply to an object in your 
scene - meaning Material(s) Presets won’t load unless you have an object selected.  Make sure you 
that you select your target object before loading a Material(s) Preset for it.
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 Material(s) Presets are great.  They can save you a lot of tedious work, and can cut time 
out of your workflow.  However, many artists view Material(s) Presets as a starting point.  Don’t feel 
limited by the presets available to you.  Once you have loaded a Material(s) Preset feel free to play 
around with any of the properties on the Editor page of the Surfaces pane.  This will help you learn 
how each property affects the surface of your object.  Remember, you can always purchase addition-
al textures and Material(s) Presets in the DAZ 3D store.  In fact one of the best ways to learn about 
surface properties and what they do is to dissect Material(s) Presets purchased from the DAZ 3D 
Store.

Section 3.7 − The Surface Selection Tool
 In addition to selecting a surface within the Surfaces pane, you 
can also select a surface directly in the “Viewport” using the Surface 
Selection Tool.  This offers a few advantages.  The first is that it allows 
you to see exactly what areas of the model are part of each surface.  
The second is that it gives you the ability to select a surface, even if you 
don’t know what the name of the surface is.

 To use the Surface Selection Tool, first activate it in the toolbar by left clicking on the tool icon.  
Once the tool is activated you can hover your cursor over the figure in the viewport - the surface you 
are currently hovering over will be highlighted and its name will be displayed next to your cursor.  If 
you left click while a surface is highlighted that surface will become selected in the Surfaces pane.  
Multiple selections can be made by holding the Ctrl/Cmd key.

Section 3.8 – Saving Material(s) Presets
 So now you’ve done the work to set up your materials.  
It doesn’t matter if you’ve only tweaked a few surface 
properties from a Material(s) Preset, or set up all of the 
materials yourself – you should be proud of your work, 
and it shouldn’t go to waste.  DAZ Studio allows you to 
save Material(s) Presets that preserve all the hard work 
you’ve put into the materials of your model.

To save a Material(s) Preset you must first make sure 
the object you want to save the preset for is your cur-
rent scene selection.  If it is not, select that object in the 
Scene pane.  Once the desired object is selected, navi-
gate to the File → Save As → Material(s) Preset… action 
and click it.  This will open the ‘Filtered Save’ dialog 
where you can choose a save location, and name your 
preset.  Once you are happy with the name and location, 
click ‘Save.’  Take note of the location you’ve saved to so 
that you can find the preset later.

http://www.daz3d.com/people/textures-skin-maps
http://www.daz3d.com/people/textures-skin-maps
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 You should now see the ‘Material(s) Pre-
set Save Options’ dialog.  This dialog allows you 
to choose which materials of the object to include 
in the preset – you may only want to include a few 
materials, for example if you are saving a preset that 
only affects the eyes of a figure.  Each surface to be 
included will have a checkmark.  If you don’t want a 
surface included then uncheck the box next to that 
surface.  You can also choose which properties are 
included for each surface.  Click the arrow next to a 
surface and you will see each property used to define 
the material.  You can check or uncheck properties 
as desired.  Once you are satisfied, click “Accept” to 
save the preset.

 You will be able to find your newly saved preset in the Presets page of the Surfaces pane, in 
the Smart Content pane [or in the Content Library pane].  If you have the object you saved the preset 
for selected, you will find your preset under the ‘Unassigned’ category.  Just double click the preset 
or drag and drop the preset onto your object to load it.

Section 3.9 – Spot Rendering
 The preview in the viewport often isn’t sufficient to see exactly 
how the materials you’ve set up in the Surfaces pane will look.  Many of 
the surface’s properties don’t take effect until after you’ve rendered the 
scene.  Unfortunately, rendering is a very resource intensive process, and 
it can take a long time to render an entire scene.

 DAZ Studio provides a Spot Render Tool that allows you to render only 
part of a scene.  You can use the Spot Render Tool to quickly check what 
your materials look when rendered.  To use the Spot Render Tool simply 
click on the Spot Render Tool icon in the toolbar.  Once the tool is activated 
you need only to left click and drag in the viewport.  When you do this a 
rectangular marquee will be drawn and DAZ Studio will render everything 
within the marquee using your current render settings.  The render will 
appear directly in the viewport.

Section 3.10 – Wrap-Up
 That’s it for Surfaces and Materials.  We hope you’re not overwhelmed and instead see the 
opportunities they provide.  Creating realistic looking Materials takes practice and experience.  The 
best way to get good at setting up Materials is to practice and experiment.  Things get a bit more fun 
and a lot less technical in the next chapter where we talk about shaping your figure.



50Chapter IV - Shaping

Shaping
Customizing Your Figures

Section 4.1 – Introduction

 If you have read Chapter 2 of this User Guide 
you should be familiar with loading actors, adding cloth-
ing and props, as well as environments.  Chapter 2 
discussed briefly how to manipulate the content you’ve 
loaded in the Parameters pane.  The discussion focused 
mostly on transforms.  To make your scene unique you 
are going to want to customize the shape of your figures 
and objects using morphs.

 So what exactly is shaping, and what is a 
morph?  In DAZ Studio, “Shaping” is the term used to 
describe the process of changing the shape of an object.  
Shaping is accomplished via morph targets.  A “Morph 
Target” or “Morph” contains information for each of the 
vertices of a 3D object, and how they should move in 
relation to each other when that morph is applied.  Fortu-
nately for us, DAZ Studio takes care of the complicated 
calculations and presents morphs to the user as a series 
of sliders in the Shaping pane.  All you have to do to 
shape your object is adjust a morph slider; it’s just that 
simple.
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Note: In this chapter we will be using the Hollywood Blvd layout and the ‘Actors, Wardrobe & Props’ 
activity.

Section 4.2 – Your Selection
 By now it should be clear that the current 
scene selection is extremely important when per-
forming any action in DAZ Studio.  Shaping is no 
exception.  The current scene selection will deter-
mine what properties appear in the various prop-
erty related panes.  When shaping you must have 
the object selected in the Scene pane.  Morphs for 
each object are categorized by region.  Selecting 
a morph “Region” (discussed below) will determine 
which morphs are displayed in the Shaping pane.

4.2.1 – The Region Navigator Tool
 In order to understand the Region Navigator Tool, and why it is 
necessary, a bit of background on regions is helpful.  In DAZ Stu-
dio, morphs on figures are assigned to regions of the body based 
on what part of the body they affect.  This makes finding morphs 
easier - if you want to find morphs that modify the arms of a figure, 
you simply look in the ‘Arms’ region.  The same is true for ‘Legs’, 
‘Hands’, ‘Face’ etc.  Morphs that affect the entire figure are found 
under the ‘Actor’ region.

 The Region Navigator tool allows you to easily select 
different regions of a figure within the “Viewport.”  To use the 
Region Navigator tool you must first activate it by clicking its 
icon in the toolbar.  Once the tool is active you can select your 
figure within the viewport.  You will see an outline around your 
figure.  The outline indicates the currently selected region.  By 
default DAZ Studio will automatically select the highest level 
region when you select a figure.  You can then select one of 
the next lower levels by clicking again within the currently se-
lected region.  You can also select sibling regions, or regions 
at the same level as the currently selected region.  If you hover 
your cursor over a region it will become highlighted and a 
tooltip will display the name of that region.  You can also right 
click anywhere on a figure and choose a region from the list 
of regions that include the point you clicked.  The DAZ Studio 
Shaping Video will explain more.

Note: The Region Navigator tool only selects regions for figures that have them.  If a figure or object 
does not have regions then the Region Navigator tool will select “Nodes” instead.

http://www.youtube.com/watch%3Ffeature%3Dplayer_embedded%26v%3DfGVgSI7a0No
http://www.youtube.com/watch%3Ffeature%3Dplayer_embedded%26v%3DfGVgSI7a0No


52Chapter IV - Shaping

Section 4.3 – The Shaping Pane
 The Shaping pane is your hub for customizing the look of an object.  The Shaping pane al-
lows you to morph objects or figures that have morphs available.  You could potentially change  your 
figure from a small child to a fierce warrior, from a giant troll to a petite woman.  The Shaping pane is 
where you can make the vision of your character and objects a reality.

 The Shaping pane is located on the left side of the DAZ Studio interface in the Hollywood 
Blvd layout.  The pane is part of the ‘Actors, Wardrobe & Props’ activity.  There are two pages in the 
Shaping pane - the Editor page and the Presets page.

4.3.1 – The Editor Page
 The Editor page of the Shaping 
pane is organized similarly to the Pa-
rameters pane – on the left hand side of 
the pane is a list of the regions for your 
selected figure or object if the selection 
has regions.  If the selection does not 
have regions you will see property groups 
displayed instead.  You can expand or 
collapse these regions/groups to reveal 
subregions/groups by clicking the ar-
row to the left of the region.  Selecting 
a different region/group or subregion/
group will change which properties are 
displayed.

 The right hand side of the pane is where you will find the actual shaping properties.  These 
are the sliders that you can adjust to change the shape of your object.  All morphs included in a 
selected region will be displayed on the right.  You can dial up any combination of morphs to shape 
your object.  To apply a morph, simply click the handle of the slider and drag it to the value you 
desire.  You can also click the nudge icons on either end of the slider or enter a numeric value by 
clicking the value for the morph and entering the desired value into the field.

 Towards the top of the left hand side of the pane 
is a drop down menu that will allow you to change your 
current scene selection.  This menu functions just like 
the Scene pane with the exception that it only lists items 
with geometry.  Cameras and lights are filtered out of 
the “Scene Selection Menu” on the Shaping pane.  This 
menu allows you to easily change your scene selection 
without having to leave the Shaping pane.
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 Below the drop down menu are two useful filters - ‘All’ and ‘Currently Used.’  The ‘All’ filter al-
lows you to see all shaping properties for the currently selected figure or object.  The ‘Currently Used’ 
filter can be used to display shaping properties that have been changed from their default load state 
- in other words shaping properties that are currently in use.

4.3.2 – The Presets Page
 The Presets page is where you will load 
Shaping Presets for your figure.  A Shaping Pre-
set contains information for the morphs of a figure.  
Essentially, when you apply a Shaping Preset to 
your figure your figure will be morphed into whatever 
shape the preset dictates - assuming the figure has 
the morphs available.  Shaping Presets provide a 
quick and easy way to shape your figure.

 You can switch to the Presets page by click-
ing the ‘Presets’ label at the top of the pane.  The 
highlighted label indicates the current page.  The 
Presets page functions like the Smart Content pane.  Categories are listed on the left hand side, in 
the “Category View.”  Shaping Presets in the selected category are displayed on the right, in the “As-
set View.”  To load a Shaping Preset all you need to do is double click the icon for the preset.

 DAZ Studio doesn’t come with any free Shaping presets for Genesis or Genesis 2.  Howev-
er, both the Genesis figure and the Genesis 2 Female figure come with a few morphs for free.  We 
encourage you to try out the morphs for both.  Look at the different regions for each figure to get a 
feel for what morphs are going to be located where.  Play around in the Editor page and adjust some 
sliders; see what you can come up with.  Remember, you can purchase additional morphs for your 
figure from the DAZ 3D store.  The Genesis Evolution: Morph Bundle for Genesis and the Genesis 
2 Female(s) Morphs Bundle for Genesis 2 Female provide a wide range of morphs for adjusting the 
shape of the figure in various ways.

Section 4.4 – Saving a Shaping Preset
 Now that you’ve adjusted a few morphs you may want 
to save your shape for later.  DAZ Studio allows you to do this 
with a Shaping Preset.  A Shaping Preset contains informa-
tion about the properties that adjust an object’s shape.  The 
save filter for this type of preset allows you to choose which 
properties are included when saving the preset.

 To save a Shaping Preset first make sure that the 
object you want to save the preset for is your current scene 
selection.  Once the object is selected, open the ‘File’ menu 
and click on the ‘Save As…’ submenu.  In the ‘Save As…’ 
submenu you will see the ‘Shaping Preset…’ action.  Click on 
the action to save the Shaping Preset.

http://www.daz3d.com/genesis-evolution-morph-bundle
http://www.daz3d.com/genesis-2-female-morphs-bundle
http://www.daz3d.com/genesis-2-female-morphs-bundle
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 The ‘Shaping Preset...’ action will launch the ‘Filtered Save’ dialog.  This dialog allows you to 
name your Shaping Preset as well as choose the location that it is saved to.  Pay attention to where 
you save the preset so you can find it later.  When you have chosen a name and location for your file 
click the ‘Save’ button.

 Once you click ‘Save’ the ‘Shaping Preset Save 
Options’ dialog will appear.  In this dialog you can 
customize your Shaping Preset.  At the top of the dialog 
you are presented with the option to have your Shaping 
Preset include information for the current frame, or in-
clude information that is animated over several frames.

 The main part of the dialog is the “Properties 
View.”  Here you will find your object listed.  If you ex-
pand your object by clicking on the arrow to the left you 
will see all of the property groups for the object.  You 
can further expand each group to see subgroups and 
individual properties.  Everything that is selected will 
be included in the Shaping Preset.  If you would like to 
exclude a property from the preset you can uncheck it.

 The ‘File Options’ section of the dialog allows you to choose whether or not to compress the 
file.  By default this option is checked.  Compressing the file will save space on your hard disk, and is 
generally a good choice.  Advanced users may wish to keep the file uncompressed so that it can be 
edited in a text editor later.
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 Once you are happy with your settings for the Shaping Preset click on ‘Accept.’  DAZ Studio 
will then save the preset and you will be able to access and load it later. 

 The easiest way to access the preset later is through the Presets page of the Shaping pane.  
To load a Shaping Preset you must first select the object you want the preset to apply to.  You can 
then load the preset by double clicking icon for the preset or dragging and dropping the icon on to 
your object.

Section 4.5 – A Quick Render
 So your figure is sculpted and shaped like a Greek 
god, or close enough anyway. Now it is time to show your 
friends right?  Well it’s fairly simple to do with a quick render.  
We’ve done these before, and we’ll do it again.  Just like last 
time we will use the default render settings.  All you need 
to do is align the camera using the camera controls so that 
your scene is framed how you want.  Once you are ready 
hit Ctrl+R on a PC or Cmd+R on a Mac to start your render.  
Once it is finished name the render and save it.

 Congratulations on finishing Chapter 4 - Shaping.  Coming this far is an impressive feat.  
However, your journey into 3D is just beginning and there is still lots to learn.  In the next chapter 
we’ll cover the process of posing your figure.
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Posing
Giving Life to Your Scene

Section 5.1 – Introduction
 Customizing the surface and shape of your figure is great.  However, your render will not be 
very interesting if you leave your figure in the default “T” pose.  This entire chapter is devoted to pos-
ing.  We’ll cover several posing tools and techniques available in DAZ Studio - so that you can give 
your character the pose it deserves.

 Posing your figure helps your render tell a story.  You can create “leading lines” for composi-
tional purposes, blend your figure with the rest of the scene, or make them pop all through posing.  
Posing should be one of the most important steps in your workflow - its importance cannot be over-
stated.  It doesn’t matter if you are building a scene for a realistic render or a stylized render, if the 
posing doesn’t look natural the render will look flat.  Giving your figure a natural looking pose and 
expression will greatly improve the quality of your renders.

 Because posing is so important, DAZ Studio has an entire activity dedicated to posing and 
animating.  Everything we cover in this chapter can be found in the ‘Pose & Animate’ activity of the 
Hollywood Blvd layout.
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Section 5.2 – Your Selection
 We learned in Chapter 4 that the current scene 
selection determines what properties appear in the Shap-
ing Pane.  The same is true for the Posing pane - the 
current scene selection will determine what properties 
are presented to you.  In the Posing pane, properties are 
placed into groups according to their respective functions.  
The property groups available are determined by the 
current scene selection.  Figures and objects with multiple nodes may have different properties and 
groups available for each node.

Note: The term “Node” is defined in Section 1.5.3

 Making a selection for posing is done in the Scene pane or the view-
port.  The only thing you need to worry about is selecting the node that you 
want to pose.  If you want to manipulate the arm of a figure, make sure the 
arm is selected.  Want to manipulate the thigh of a figure?  No problem, just 
select the thigh you want to pose.  For a review of the Scene pane you can 
check out Section 2.4.

 You can also change the selected node 
by using the Universal Tool.  Simply activate the 
Universal Tool from the toolbar and click the node 
of the model you want to manipulate from within 
the viewport.  DAZ Studio will highlight a node if 
you hover your cursor over it.  You can also right 
click in the viewport and DAZ Studio will display 
a menu with a list of nodes that are selectable 
from the point that you clicked.  This allows you to 
select clothing, hair or other followers when they 
are conformed to a figure.

Section 5.3 – The Posing Pane
 The Posing pane is where you will find all 
of the properties for posing an object.  The pane 
is located on the left hand side of the DAZ Studio 
interface when you are using the Hollywood Blvd 
layout and are in the ‘Pose & Animate’ activity.  
The pane is broken down into two pages - the Editor page, and the Presets page.  If this sounds 
familiar, it is because the Surfaces pane and Shaping pane are organized practically the same way.  
You can switch between the two pages by clicking on their respective labels at the top of the Posing 
pane.
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5.3.1 – The Editor Page
 The Editor page is divided into two 
columns.  On the left, in the “Group View,” is a 
list of all the property groups available for your 
current scene selection.  The property groups 
are displayed the same way as they would be 
in the Parameters pane.  The only difference is 
that in the Posing pane, only property groups 
that contain posing properties appear.  You can 
select any property group by clicking on it.  You 
can expand or collapse any property group by 
clicking the arrow next to the group.

 On the right hand side of the pane, in the “Property View,” is where you will find the individual 
posing properties.  When you select a property group on the left side of the pane all properties in that 
group will be available on the right hand side.  You can manipulate a property by clicking on the slider 
and moving it to the left or right.  DAZ Studio also allows you to enter a numeric value for a property 
– click on the number and enter a value into the field.

 The Editor page of the Posing pane has a few 
other features worth pointing out.  On the left hand 
side above the property groups you can change your 
current scene selection using the drop down menu.  
This drop down menu is like a miniature version of the 
Scene pane and allows you to quickly select various 
items within the scene.

 Below the drop down menu you have the option 
to view ALL posing properties for your current scene 
selection.  To do this click the ‘All’ filter.  On the right 
hand side you will see every posing property available.

 You can also limit your selection to just posing properties that are currently used.  When you 
have the ‘Currently Used’ filter selected only posing properties that you have altered will be displayed 
on the right hand side.  This is an easy way to see exactly what properties are modifying your current 
scene selection.

 The most important thing to remember about the Editor page is that the properties displayed 
to you are selection dependent.  The first selection you need to be aware of is your current scene 
selection.  Make sure you have the correct node of the figure or node in the scene selected.  The 
second selection you need to be aware of is the property group selection, on the left hand side of the 
pane.  If you can’t find a desired posing property try changing your property group selection, or using 
the ‘All’ filter.  The Editor page also provides a text search function at the top of the pane.
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 You will not improve your posing skills unless you practice.  We recommend taking a few min-
utes to play around in the Editor page.  Change both your current scene selection, and the property 
group selection.  Adjust each slider to see how it affects your figure.  If you are still unsure about the 
Posing pane this video should help: Posing Pane Overview

5.3.2 – The Presets Page
 The Presets page of the Posing pane is where you can load Pose Presets for your figure.  A 
Pose Preset applies a predetermined pose to a figure.  Pose Presets are useful because they save 
you time.  Instead of having to tediously pose each node of a figure you can apply a Pose Preset 
and save yourself the work.  Many people enjoy the process of posing their figure.  For most artists 
a Pose Preset acts as a starting point for the posing process.  They apply the Pose Preset from the 
Presets page and then tweak the pose using the properties in the Editor page.

 The Presets page is organized the same way the 
Smart Content pane is.  On the left hand side of 
the pane you have a list of available categories.  
Clicking on a category will select it, and clicking 
the arrow next to a category will expand it to 
reveal subcategories.  On the right hand side is 
where you will find all poses associated with the 
selected category.

 To load a Pose Preset all you need to do is dou-
ble click on its icon in the right hand side of the 
pane.  You can also left click and drag the Pre-
set onto your figure.  Right clicking the icon will 
display additional options for the file including the 
option to merge the pose into the scene.

Note: Some Pose Presets contain rotation information outside of the normal figure limits.  If you load 
a Pose Preset like this you will be prompted to turn limits off.  In this case it is recommended that 
you allow the limits to be turned off if you would like the pose your figure takes on to match the pose 
contained within the file.

 The Presets page functions like the Smart Content pane with respect to filtering as well.  Only 
presets that are compatible with your current scene selection will be displayed in the editor page.  
Make sure that the figure you want to load a preset for is selected in the Scene pane.

 DAZ Studio ships with several Pose Presets for both the Genesis and the Genesis 2 Female 
figures.  If you have either figure loaded in your scene you can select the figure and open the Presets 
page to see the poses that are available.  Just look under the Poses category.  Most Pose Presets 
are categorized by both function and region.  Search through categories and find a Pose Preset you 
find interesting and load it.  Remember, you can always purchase additional Pose Presets from the 
DAZ 3D store.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/posing/videos/posing/start
http://www.daz3d.com/animations-poses
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 Another thing to be aware of is that you can load Pose Presets from the Smart Content pane 
and the Content Library pane.  The Presets page is provided as a convenience for locating and load 
Pose Presets, but there are other options available.

Section 5.4 – Posing in the Viewport
 While many people find the Posing pane sufficient, there are those who prefer a more direct 
approach to posing.  For those individuals, posing directly in the viewport is often easier.  Many peo-
ple use a combination of the Posing pane and viewport posing tools to pose their figures.  Generally 
large movements are done in the viewport; smaller movements can then be tweaked in the Posing 
pane’s Editor page by either manipulating the sliders or entering numeric values.

 DAZ Studio offers several tools to pose your figure in the viewport.  We’ll cover the two eas-
iest and most common tools here.  They are the Universal Tool, and the Posing Tool.  You can find 
more about each in the sections below.

5.4.1 – The Universal Tool
 If you’ve read through earlier chapters in this User Guide you should be familiar with the 
Universal Tool.  We’ve used the Universal Tool to translate, rotate and scale entire figures within the 
viewport.  The Universal Tool can also be used to translate, rotate and scale the nodes of a figure in 
the viewport.  This means you can use the Universal Tool to pose your figure right in the viewport.

 You can activate the Universal Tool from within 
the toolbar near the top of the activity.  Just left click on 
the tool to activate it; once it is active the tool will be high-
lighted.

 To begin posing you need to select the figure you 
want to pose.  If you hover your cursor over your desired 
figure the figure will be highlighted in the viewport.  Click-
ing will select the figure.  Once the figure is selected you 
can use the Universal Tool to select any node on the fig-
ure.  As you hover your cursor over the figure you will see 
that certain body parts become highlighted.  Left clicking 
will select that particular node.

 Once a node is selected you can use the Uni-
versal Tool to manipulate that node in the viewport.  Remember, you have several gizmos at your 
disposal that allow you to rotate, translate and scale your selection.  You will probably find that the 
easiest of these three to use is rotation.  This is because rotation affects only the selected node while 
translation can affect nodes further up the chain.  To rotate a node within the viewport using the Uni-
versal Tool, left click on the red, green or blue arcs and drag in the direction you wish to rotate.

Note: As a quick refresher, red represents the X-axis, green the Y-axis, and blue the Z-axis.
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 Posing in the viewport can be especially helpful when beginning to pose your figure as it can 
give you a sense of direct control over the figure.  The Universal Tool is invaluable when trying to 
pose hands, and fingers.  Play around with rotation and translation for each node on the figure to get 
a sense for how each node reacts to both translation and rotation.  This will help you learn the advan-
tages and drawbacks of using the Universal Tool to pose in the viewport.

5.4.2 – The Pose Tool
 The Pose Tool is another way for you to pose your fig-
ure from within the viewport.  The Pose Tool offers a few cool 
features that make posing simple.  The first is the “Free Rotate 
Control”, the sphere in the center of the tool, which allows you 
to manipulate rotation values on a node, across all of its axes 
simultaneously.  The tool also includes individual “Pose Con-
trols”, the concentric colored rings, for each axis of the node 
that graphically represent the current degree of rotation and 
its limits.  The red ring represents the X-axis, the green rep-
resents the Y-axis, and blue represents the Z-axis.

 In the Hollywood Blvd layout, the Pose Tool is 
hidden by default.  You can use the “Viewport Op-
tions Menu” discussed in Section 2.4.3 to unhide the 
Pose Tool.  Click on the viewport options menu and 
select ‘Show Pose Tool.’  Depending on your current 
scene selection you may or may not see the Pose Tool 
appear in the upper left hand corner of the viewport.  
If you don’t see the Pose Tool appear change your 
current scene selection to any bone on your figure.

Note: If you have the root node of your figure selected 
you won’t see the Pose Tool.  You need to have a bone 
of the figure selected for the tool to appear

 You can manipulate the node on a single axis by using the 3 colored rings.  Just click any-
where on a ring and drag to pose on that axis.  The black line represents the current position of the 
selected node.  You will notice that each ring is two toned this is to represent the rotational limits for 
each axis.  The vibrant tone represents the poseable region while the muted portion of the ring rep-
resents values outside of the rotational limits.

 The free rotate sphere allows you to rotate the currently selected bone about all three axes 
at the same time.  To use the free rotate sphere, simply click on the sphere and drag.  As you use 
the sphere notice the “Angle Indicator” for each axis move within its defined range, as you rotate the 
bone.  This allows you to see how the free rotate control affects each axis of the bone.
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 The icon in the upper left of the Pose Tool represents the “Re-
store Options Menu.”  In this menu you can choose to restore 
the pose of your currently selected bone, or for the entire figure.  
This is useful if you’ve messed up your pose and want to start 
fresh.  You can also use this menu to turn the rotation limits for 
the selected bone on or off.

 
 The icon in the upper right of the Pose Tool represents the 
“Pinning Options Menu.”  You can use this menu to pin bones in 
place, or unpin any pinned bones.  Keep in mind that these are 
soft pins, so when a bone is pinned it tries to stay in place, but if 
the movement of another bone forces it to move the pinned bone 
will move and a dashed line will be drawn from the pin to the bone.  
You can see this yourself.  Try pinning the foot of the Genesis 
2 Female figure, it doesn’t matter which one, and then translate 
the hand.  You will see that at a certain point, when the hand is 
dragged far enough, the foot will move.  Using pins to pose takes 
practice and isn’t recommended for new users.

 The Pose Tool is just another way to pose your figure in the viewport.  Like all posing meth-
ods it requires practice.  We recommend playing around with the Pose Tool for a little bit.  See if you 
like posing with it.  It has the potential to be a powerful part of your posing workflow.  Even if you 
don’t actively use the Pose Tool you may find it useful to have it visible in the viewport.  You can use 
the angle indicators to quickly see the range of motion for each bone.

Section 5.5 – Expressions
 Moving the bones of a figure around and posing the body 
is only part of the posing process.  Any good render is going to 
include realistic expressions for each figure in the scene.  Ex-
pressions are an integral part of the posing process.  You could 
have the best pose in the world, but if you don’t have an expres-
sion to match, the render will not live up to its potential.

 Expressions are done through the Posing pane.  If you 
have a Pose Preset for an expression it can be loaded through 
the Presets page like any other Pose Preset.  If you are creating 
the expression yourself you will need to use the Editor page.

 To access the expression pose controls for a figure, first 
select the head of the figure in the Scene pane or the Posing 
pane’s scene selection menu.  It is very important that you select the head of the figure.  If you have 
any other node of the figure selected the expression pose controls won’t show up in the Posing pane.
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 Once you have the head of your 
figure selected you will see the ‘Pose 
Controls’ property group appear in the 
Posing pane.  If you expand this group 
you will see the ‘Head’ and ‘Neck’ groups.  
All pose controls for the face and head will 
be found under the ‘Head’ group.  Ex-
pand the group and you will see property 
groups for the ‘Brow’, ‘Cheeks’, ‘Eyes’, 
etc.  There is even an ‘Expressions’ group 
that contains full expressions that can be 
applied.

 You can use these pose properties 
by themselves or in combination with one another to create the perfect expression.  These properties 
work just like any other property, you simply move the slider to activate the property.  We recommend 
exploring the various property groups in the head.  Play around with the different pose properties 
available to see what you can come up with.  We’re sure you’ll be able to make great expressions.

 The Genesis and Genesis 2 Female figures ship with several expressions, and pose controls 
for the face.  If you need more expressions or pose controls you can purchase more from the DAZ 
3D store.

http://www.daz3d.com/animations-poses/expressions
http://www.daz3d.com/animations-poses/expressions
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Section 5.6 – Saving a Pose Preset
 Now that you’ve read through this chapter you have the tools to become a posing expert.  If 
you aren’t now, you will be soon with practice.  After spending hours getting the perfect pose for your 
figure you won’t want that work to go to waste.  DAZ Studio allows you to save your own Pose Pre-
sets so that you can preserve your hard work and use it later.

 To save a Pose Preset go to File → Save As 
→ Pose Preset…  You can also click the Pose Preset 
action in the toolbar.  Both of these options will bring up 
the ‘Filtered Save’ dialog.  This is where you choose the 
save location and name for the Pose Preset.  Take note 
of where you save the file so that you can find the Preset 
later.  Once you have chosen a name and location, click 
‘Save.’

 The ‘Pose Preset Save Options’ dialog will 
launch and present you with several options for your 
Pose Preset.   In the ‘Animation Range’ panel you can 
choose whether to record an animated sequence or sin-
gle frame pose.  Unless you have created an animation 
choose the ‘Current Frame Only’ option.

 The “Properties List view” allows you to 
choose which pose properties are included 
in the preset.  You can expand the skeleton 
of the figure, and the property groups for 
each bone by clicking the arrow next to the 
bone or group.  To exclude a property or 
Node from the Pose Preset uncheck it from 
the list.

Note: You probably won’t want your pose to 
include translation information for the entire 
figure.  Make sure you uncheck the ‘Gener-
al’ property group underneath the root node 
of the figure.  This will prevent the Pose Pre-
set from changing the location of the entire 
figure when the preset is applied.

 The last section of the dialog is the ‘File Options’ panel.  Here you can choose whether or not 
to compress the file.  Compressing the file saves hard drive space and makes the file more compact.  
The downside is that the file can’t be edited directly in a text editor - it must be “unzipped” first.  Only 
advanced users need to worry about manually editing Pose Presets.  In general compressing the file 
is the best option.
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Note: Unzipping of compressed files can be done through the Batch Convert pane.

 Once you have set all of the options for the Pose Preset, click ‘Accept.’  DAZ Studio will then 
save out the preset.  You can access the preset in the Presets page of the Posing pane.  It will be 
in the ‘Uncategorized’ category.  You can load the preset just like any other preset either by double 
clicking the icon, or by dragging and dropping the icon onto the figure.

Section 5.7 – Wrap-Up
 You should now have enough information to begin posing your own figures.  Remember that 
creating realistic poses and expressions takes practice.  Be patient with yourself, and take your time.  
You shouldn’t feel rushed when creating poses.

 One final thing to note about poses is that many poses are figure shape dependent.  When 
creating a pose it is best to shape your figure first.  If you do it the other way around you may find 
you have collisions in your pose, or things don’t quite line up after you’ve shaped your figure.

 When using Pose Presets remember that the creator of the preset designed it for a specific 
shape.  The Pose Preset will usually indicate which figure and shape the Pose Preset is for.  You can 
use most presets on other figures and shapes but it usually requires a bit of tweaking in the Posing 
pane’s Editor page to get the pose to look right.
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Cameras and Views
A Visual Portal to the 3D World

Section 6.1 – Introduction
 In DAZ Studio cameras and views allow you to see the 3D world you are manipulating.  With-
out these tools you wouldn’t be able to preview or render a scene.  “Views” allow you to navigate 3D 
space and also view the scene orthographically while you work.  “Cameras” allow you to frame your 
scene for render and apply effects such as “Depth of Field.”  By mastering these concepts you will 
not only be able to efficiently navigate and view your 3D scene, but render your scene in an artistic 
way.

 By the end of this chapter you will be able to load new cameras as well as Camera(s) Pre-
sets.  You will be able to change your view in the “View Selection Menu” and know what each view 
is for.  In this chapter you will be introduced to the Cameras pane and important camera properties 
such as ‘Focal Length’, ‘Focal Distance’ and ‘Depth of Field.’  Finally, you’ll learn how to save all of 
your hard work in a Camera(s) Preset.

 As we move into this chapter on cameras it is important to note that the Hollywood Blvd 
layout in DAZ Studio has an activity devoted to cameras and lighting.  We will be using the ‘Lights & 
Cameras’ activity for this chapter.  If you are following along, make sure you are in this activity.

Section 6.2 – Loading a Camera
 Before you can manipulate a camera you need one in your scene.  The DAZ Studio default 
startup scene already has a camera loaded in it, but if you’ve just opened a new scene there won’t 
be any cameras.  There are several ways to load a camera into your DAZ Studio scene.  You can 
load a new camera manually, using the ‘New Camera...’ action or you can load a Camera(s) Preset.
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6.2.1 – Loading a Camera Manually
 If you want a brand new camera in your scene, load-
ing it manually with the ‘New Camera...’ action is your best 
bet.  The ‘New Camera...’ action will load a new camera that 
you can translate, rotate and manipulate.  In fact you will 
probably need to do all three of these things as the default 
load position for the camera probably won’t suit your needs.  
Don’t worry though, that will be covered later.

 To load a new camera, open the ‘Create’ menu and 
choose the ‘New Camera...’ action.  This will launch the ‘Cre-
ate New Camera’ dialog.  In this dialog you can name your 
new camera.  You can choose a name for the camera or just 
use the default name.  Clicking the ‘Show Options >>’ but-
ton will reveal more options when loading the camera.  Two 
options of note are ‘Apply Default Settings’ and ‘Apply Active 
Viewport Transforms.’

 ‘Apply Default Settings’ will load the camera at 
the default position.  ‘Apply Active Viewport Trans-
forms’ will load the camera so that it has the same po-
sition and direction as your active view.  This means 
when you view through the new camera the view will 
be identical to the view you had when you created the 
camera.  This is useful if you are using ‘Perspective 
View’ and you’d like to create a camera that matches 
your current view.

 Once you are ready to load the camera click the ‘Accept’ button.  If the Scene pane is open 
you will see the new camera appear there.  In DAZ Studio cameras are like any object, they can be 
selected, translated, rotated, scaled and deleted.

6.2.2 – Camera(s) Preset
 Some artists will distribute Camera(s) Presets with their 
scenes.  These presets will load a camera or multiple cameras into 
your scene.  Keep in mind that by default a Camera(s) Preset will 
replace the cameras you currently have in your scene.  Generally 
Camera(s) Presets work best with the scene they were designed 
for.  This is because framing, depth of field etc. are based on what 
is in the scene.  That doesn’t mean you can’t load a Camera(s) 
Preset for a scene it wasn’t intended for, just don’t expect it to look 
good.
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 Loading a Camera(s) Preset will be discussed in detail in Section 6.4.2 when the Cameras 
pane Presets page is discussed.  For right now it is sufficient to know that you can load a camera 
through Camera(s) Presets.

Section 6.3 – Changing your View
 So what happens if you have multiple cameras in your scene?  
How do you switch your view between the cameras?  You may have 
noticed that when you load a camera it doesn’t automatically switch 
your view.  To handle view switching DAZ Studio provides the “View 
Selection Menu.”  If you recall, the view selection menu was discussed 
briefly in Section 2.4.1. With the view selection menu you can switch 
views.

 DAZ Studio provides views in addition to the cameras in the scene.  These views can’t be 
selected, animated, or deleted like cameras can.  They respond to the viewport controls, but they 
can’t be manipulated beyond that.  There is one perspective view and six orthographic views.  Listed 
below these views in the view selection menu are all of the cameras currently in the scene.

6.3.1 – Perspective View
 The ‘Perspective View’ acts as a sort of “Director’s View-
finder.”  It allows you to pan, zoom, rotate and view the scene 
in 3D.  However, there is no actual camera.  Manipulation of 
the ‘Perspective View’ must be done with the viewport con-
trols but these manipulations can’t be accessed later.

 ‘Perspective View’ is best used when setting up your 
scene.  When using the ‘Perspective View’ think of yourself 
as a director looking through his thumbs and forefingers as a 
“frame” for the shot.  You are scouting out the location, set-
ting things up, giving commands to the actors, all this while 
you aren’t carrying a camera around with you.  If you happen 
to find the perfect shot while doing this you can create a new 
camera using the ‘Apply Active Viewport Transforms’ option.  
Hopefully you have plenty of practice using the ‘Perspective 
View’ by now, since it is the default view in DAZ Studio.

 The ‘Perspective View’ is great for setting up your scene.  You can even “spot render,” or do 
an entire render through the ‘Perspective View.’  We don’t recommend using the ‘Perspective View’ 
for your final render, however, as you won’t have access to any of the cool camera effects that will be 
discussed later.
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6.3.2 – Orthographic Views
 “Orthographic” or “orthogonal” refers to right angles.  
The orthographic views in DAZ Studio are all at 90° angle to 
the scene.  The views available are, in order of list appear-
ance, ‘Front View’, ‘Left View’, ‘Right View’, ‘Back View’, ‘Top 
View’ and ‘Bottom View.’  When you select any of the views 
the viewport will be “locked” in that 90° angle until you change 
the view.  The orthographic views will respond to all of the 
viewport controls except for the orbit and the camera cube.

 In addition to being set at a 90° angle to the scene, 
orthographic views also lack perspective.  In an orthographic 
view everything is flattened to a 2D image.  This may sound 
limiting, but is actually quite useful.  You have your perspective 
view and cameras to view in 3D.  However, looks can be de-
ceiving when viewing 3D space.  The orthographic views can 
be used to help you get things precisely lined up.  For example 
if you want to pose a figure in a chair you could use the top 
and side orthographic views to make sure the figure is lined up 
properly in the chair.

6.3.3 – Camera Views
 Underneath the orthographic views in the view selection menu 
are the cameras in your scene.  Selecting a camera will cause you 
to view your scene through that camera.  When you use any view-
port controls to pan, zoom, rotate, bank, etc. the camera, these 
transforms are applied to the camera itself.  Just like in real life 
viewing through a camera is the easiest and most intuitive way to 
set up your shot.

 Keep in mind that viewing through a camera doesn’t mean that 
camera is your current scene selection.  Viewing through cameras 
and selecting cameras are two different things.  To select a camera 
you must select it in the Scene pane.

Section 6.4 – The Cameras Pane
 The Cameras pane is located on the left side of the Hollywood Blvd layout, in the ‘Lights & 
Cameras’ activity.  If you have read the chapters on Surfaces, Shaping, and Posing then the Camer-
as pane should look very familiar, as it shares the same basic layout as the Surfaces, Shaping and 
Posing panes.  The Cameras pane is broken down into two pages – the Editor Page and the Presets 
page.  The Editor Page is where you can manipulate properties for a camera while the Presets page 
is where you can load Camera(s) Presets from.



70Chapter VI - Cameras and Views

6.4.1 – The Cameras Pane Editor Page
 The Editor Page of the Cameras 
pane is divided into two main sections.  On 
the left hand side of the page in the “Prop-
erty Group View” is where you will see 
all of the property groups for your current 
scene selection.  Keep in mind that nothing 
will be displayed unless your current scene 
selection is a camera.  You can click on 
a property group to select it and you can 
expand a property group by clicking on the 
arrow next to the group.

 On the right hand side of the page, 
in the “Property View,” is where you will 
find the individual camera properties in the 
selected property group.  Remember, in 
order for you to see any properties in the 
right column of the Editor page you need to first have a camera selected and second you must have 
a property group selected on the left hand side.

 The Editor Page also allows you to display all properties for a selected camera.  To do this 
select the ‘All’ filter on the left hand side of the pane.  You can also choose to display all properties 
for the camera that have been modified from their load state.  To do this, select the ‘Currently Used’ 
filter on the left hand side of the pane.

 You can change your current scene selection in the 
Cameras pane’s Editor Page.  In the top left corner of the 
pane you will find a drop down menu which lists every camera 
in the scene.  You can use this drop down menu to change 
your selected camera.  With this menu you don’t have to 
switch to the Scene pane to select a different camera.  The 
drop down menu also has an option to load a new Camera.  
Clicking the ‘Add a Camera…’ action does the same thing as 
the ‘New Camera...’ action in the ‘Create’ menu.

 Each camera in DAZ Studio will have three property 
groups – ‘General’, ‘Display’, and ‘Camera.’  The ‘General’ 
group contains transform properties which you should be fa-
miliar with.  You can use these properties to move the camera, 
or you can use the viewport controls to move a camera when 
it is your active view.
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 The ‘Display’ group contains properties that determine how the camera is displayed in the 
viewport.  You can play around with these properties to see how they affect the look of the camera.  
None of these properties will affect how the final render looks, just how the camera looks in the view-
port.

 Properties in the ‘Camera’ group will affect the final render.  ‘Perspective’, ‘Focal Length’, 
‘Depth of Field’, ‘Focal Distance’, and ‘F/Stop’ can all be manipulated to change the appearance of 
your render.  Most of these properties are also found in real world cameras and function much the 
same.  Below is a brief description of each property.

Perspective
 The ‘Perspective’ property can only be turned on or 
off.  When perspective is turned on the camera will function 
like a normal camera.  Everything viewed through the cam-
era will have depth and perspective.  When perspective is 
turned off the image flattens or becomes isometric.  If you 
view through a camera and toggle perspective on and off 
you can get a feel for how this property will affect your final 
render.

Focal Length (mm)
 ‘Focal Length’ determines the field of view for your 
camera.  Back in Section 2.4.6 we discussed the zoom view-
port control. If you remember the term “Focal Zoom” was in-
troduced.  ‘Focal Length’ is the property that affects the focal 
zoom.  As you increase ‘Focal Length’ the camera zooms in 
and vice versa.  Extreme values for this property will distort 
the perspective.

 You can manipulate ‘Focal Length’ by adjusting the slider for the property.  Just click the 
handle on the slider and move it left or right.  You can also enter a numeric value for the property by 
clicking on the numeric value and entering a new value into the field.

Depth of Field
 ‘Depth of Field’ determines whether or not the entire 
image is in focus.  When ‘Depth of Field’ is turned on any-
thing outside of the focus area will be blurred.  When ‘Depth 
of Field’ is turned off the entire image will be focused in the 
final render.  ‘Depth of Field’ can be used to create some 
really cool effects.  By putting your main character in focus 
and blurring the foreground and background you can draw 
attention to your character and make him or her stand out.
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Focal Distance
 When ‘Depth of Field’ is turned on the ‘Focal Dis-
tance’ determines how far away from the camera the focus 
area is.  You will want to make sure that the ‘Focal Distance’ 
is set so that your main character is at or near the “Focal 
Point.”  If you aren’t viewing through the camera you are 
manipulating the focal point - indicated by a green and red 
cross.

 You can change the ‘Focal Distance’ by using the slider for the property.  Click on the slider 
and move it left or right to decrease or increase the ‘Focal Distance.’  You can also enter a numeric 
value by clicking on the value label for the property and entering a new value in the numeric field.

F/Stop
 The ‘F/Stop’ determines the distance between the 
near and far ‘Depth of Field’ planes.  Anything in front of the 
near plane and anything behind the far plane will be out of 
focus.  By increasing the ‘F/Stop’ you increase the distance 
between these two imaginary planes, and thus increase 
what is in focus.  Decreasing the ‘F/Stop’ value will move 
these planes closer together and decrease the amount of 
the image that is in focus.  You can use ‘Focal Distance’ and 
‘F/Stop’ together to control what is in focus when ‘Depth of 
Field’ is enabled.

 You can manipulate the ‘F/Stop’ by using the slider for that property.  Click on the slider and 
move it left or right to decrease or increase the focal distance.  You can also enter a numeric value 
by clicking on the value for the property and entering a new value in the numeric field.

 The Cameras pane Editor page allows you great control over each of the cameras in your 
scene.  Use the Editor page to customize each of your cameras in your scene.  If you’d like to learn 
more about the properties available in the Editor page of the Cameras pane, please watch this video: 
Cameras Editor.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/cameras/videos/cameras_editor/start
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6.4.2 – The Cameras Pane Presets Page
 Recall back to Section 6.2.2.  In that section we learned 
that cameras can be loaded using Camera(s) Presets.  
These Camera(s) Presets can be loaded from the Presets 
page of the Cameras pane.

 The Presets page is organized just like the Smart Con-
tent pane.  On the left hand side, in the “Category View”, 
you will see available categories.  By default everything will 
be categorized under ‘Cameras.’  On the right hand side 
of the pane is where all Camera(s) Presets in the selected 
category can be found.

 To load a Camera(s) Preset you can double 
click the icon.  Alternatively, you can drag and drop 
the icon for the preset into the DAZ Studio viewport.  
Remember when you load a Camera(s) Preset it will 
replace all the cameras in your scene.  However, if you 
hold down the Ctrl key on the PC or the Cmd key on 
the Mac when loading the preset you will launch the 
‘Camera Preset Load Options’ dialog.  In this dialog 
you have a drop down menu with the options to re-
place all cameras, replace only the selected camera, or 
simply add the cameras in the preset to the scene.  If 
you choose ‘Add’ the cameras in your scene will not be 
replaced.

 You can learn more about the Cameras pane 
Presets page in this video: Cameras Presets.

6.5 – Saving a Camera(s) Preset
 Just as with surfaces, shaping, and posing, setting up 
your cameras takes work.  Once you’ve set up your cam-
eras for a scene you may want to save those settings for 
later.  You can do this by saving a Camera(s) Preset.

 To save a Camera(s) Preset go to File → Save As → 
Camera(s) Preset…  To save a preset for an individual 
camera select that camera in the Scene pane, if you’d 
like the preset to include all cameras in the scene then 
your current scene selection doesn’t matter.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/cameras/videos/cameras_presets/start
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 Clicking the ‘Camera(s) Preset…’ action in the ‘Save As’ submenu will launch the ‘Filtered 
Save’ dialog.  In this dialog you can choose a name for your preset and a location to save it.  Once 
you have named your preset and chosen a save location click ‘Save.’  Take note of where you are 
saving the preset so you can find it later.

 Clicking save opens the ‘Camera(s) Preset 
Save Options’ dialog.  The dialog is broken into 
three sections – Animation Range, Camera Data, 
and File Options.  In ‘Animation Range’ you can 
choose to make the preset for the current frame, 
or over an animation range specified by the ‘Start 
Frame’ and ‘End Frame’ fields.  Under ‘Camera 
Data’ you can choose whether the Camera(s) Pre-
set will include information for all cameras in the 
scene, or only the selected cameras.  ‘File Options’ 
allows you to choose whether or not to compress the file.

 Once you have your options set click ‘Accept’ and DAZ Studio will save the preset.  You can 
find your Camera(s) Preset in the Presets page of the Cameras pane.  It will be located under the 
‘Uncategorized’ category.

6.6 − Wrap-Up
 The camera properties in DAZ Studio allow you to create really great effects.  Try playing 
around with ‘Depth of Field’, ‘Focal Distance’, and the ‘F/Stop’.  These three properties allow you 
change the focus of your scene.  Remember, your camera settings determine how others will view 
your art.  Don’t discount the importance of cameras in DAZ Studio; they can make the difference 
between a good and great render.
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Lights
Illuminating Your 3D World

Section 7.1 – Introduction
 Unless you live in a cave, light permeates your world.  It is literally all around us.  When we 
see objects in the world what we are sensing is light reflected from the surface of that object.  The 
light hits our eyes, is focused to our retina and then absorbed by our photoreceptors.  This sets off an 
intricate chemical reaction that starts a synapse along the optical nerve which eventually makes its 
way back to the visual cortex in the occipital lobe.  And the entire process all begins with light.

 So why is all this relevant?  It is light that gives life to the world around you.  In the same way, 
the light in your 3D scene gives it life.  Whether you want your image to look warm and vibrant, or 
cold and dark you need light to make this happen.  The lighting in your scene helps tell your story just 
as much as the figures do.  Humans are very intuitive, even someone who isn’t a trained artists will 
be able to spot bad lighting in a render.

 This chapter will teach you about the different types of lights available in DAZ Studio and how 
to load them into the scene.  We’ll go over the Lights pane, properties specific to lights and how to 
edit those properties.  Finally we’ll discuss techniques to set up lighting in your scene.  Keep in mind 
that for this chapter we’ll still be in the ‘Lights & Cameras’ activity in the Hollywood Blvd layout.
.
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Section 7.2 – DAZ Studio Default Lighting
 Many of you may be wondering why you need to light the scene.  In the renders we’ve done 
so far in this User Guide everything has been lit.  This is because DAZ Studio uses a type of default 
lighting called “Headlamp” lighting.  Essentially your view is lit by an imaginary headlamp.  DAZ 
Studio uses headlamp lighting when no other lights are loaded in the scene.  Headlamp lighting is 
great to help you preview and set up your scene.  Everything you look at will be perfectly illuminated.  
However, headlamp lighting isn’t realistic.  When you do your final render you’ll need a different light 
set up to make the lighting look natural.

 When you load a light into your scene DAZ Studio turns off headlamp lighting, and the lighting 
in the viewport is determined by the light(s) in the scene.  The number of lights that can be previewed 
in the viewport is determined by your video card.  Most video cards support up to 8 lights.

 Being able to preview the current scene lighting is a great 
way to get a feel for how the lighting will look in the final render.  
There may be times when you’d like to switch back to headlamp 
lighting for your preview.  Perhaps you are trying to move figures 
in a dimly lit area of the scene.  You can switch back to headlamp 
lighting by toggling the ‘Use Scene Lights’ action in the toolbar.  
When the icon for the action is highlighted DAZ Studio will dis-
play the preview using the current scene lighting, otherwise DAZ 
Studio will display the scene using headlamp lighting.

Note: In Chapter 7 we will continue using the ‘Lights & Cameras’ activity.

Section 7.3 – Adding a Light
 New lights can be added to the scene using the actions in the ‘Create’ menu.  DAZ Studio 
has four distinct types of lights – Distant Light, Spotlight, Point Light, and Linear Point Light.  We will 
discuss each light type later in this section.  Each light has its own action in the ‘Create’ menu.  To 
load a light choose that light’s action in the ‘Create’ menu.  For example to load a distant light go to 

Create → New Distant Light…

 Choosing any of the New Light actions will launch the 
‘Create New Light’ dialog.  If this dialog looks familiar it 
is because it uses the exact same interface as the ‘Cre-
ate New Camera’ dialog introduced in Chapter 6.  In this 
dialog you can name your new light.  It is generally best 
practice to name the light according to its function (i.e. 
Key Light, Rim Light, Flood Light, Fill Light etc.).  This will 
allow you to quickly identify each light by its function in 
the Scene pane.
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 If you click the ‘Show Options >>’ 
button the dialog will expand to reveal more 
options for the light.  You can choose to load 
the light at the default load location, or to apply 
the ‘Active Viewport Transforms.’  Choosing 
the latter will load the light at the position and 
angle of the current active viewport.  Once you 
are satisfied with your settings click ‘Accept’ to 
load the light.

 As the light loads into the scene you 
should notice a drastic change in the lighting 
as headlamp lighting is turned off and DAZ Studio displays the preview using the light you just load-
ed.  If you look in the Scene pane you will see your light listed.  Lights are selectable objects in your 
scene; they can be manipulated just like any other object.

7.3.1 – Distant Lights
 A “Distant Light” acts like a light source from an infinite distance.  
In some 3D applications it is referred to as an “Infinite Light.”  Because 
the light source is from an infinite point away, translation within the 
scene is irrelevant.  The only thing that is important is the rotation of 
the light, as that determines the direction from which the light is com-
ing.  The arrows of the “Distant Light Avatar” indicate the light’s direc-
tion.

 Distant lights are great at illuminating large portions of the scene.  Often they are used to 
mimic sunlight.  Try loading a distant light into your scene and playing around with the rotation to see 
how the light behaves.  As you familiarize yourself with the distant light you will find plenty of uses for 
it.

7.3.2 – Spotlights
 Spotlights are useful for illuminating specif-
ic areas of your scene.  Just as in the real world, 
a “Spotlight” in DAZ Studio emanates in a cone 
shape.  This means that both the translation and 
rotation of the spotlight determine where the light 
shines.

 Spotlights are great at mimicking things like 
car headlights, open face lamps, flashlights, and of 
course spotlights.  The latter may sound facetious, 
but keep in mind that spotlights are common in 
photo shoots.  Don’t underestimate the usefulness 
of a spotlight when illuminating your scene.
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7.3.3 – Point Lights
 “Point Lights” function much like a light bulb, 
or a candle.  A point light is a single point in 3D space 
that emanates light.  Unlike the distant light where 
only rotation is important, point lights aren’t affected 
by rotation since light emanates in all directions from 
the point.  Instead, point lights are affected by trans-
lation.  You can use the translation properties for the 
light to change where the light emanates from.

 Point lights don’t have much intensity to them, 
so it is difficult to light an entire scene with just a 
point light.  Point lights are great for candles, light 
bulbs, chandeliers.  It is possible to light an entire 
scene with point lights, but it is much easier to use 
point lights to accent your existing lights.

7.3.4 – Linear Point Lights
 “Linear Point Lights” are similar to point lights in 
that there is a single point in 3D space and light em-
anates from that point.  The difference between the 
two is that while a point light follows the physical laws 
of light (the intensity of light is inversely proportional 
to the square of the distance from the source).  A 
linear point light doesn’t follow these laws.  Instead it 
allows you to set the point at which the light falls off.  
This allows you to have the effect of a point light, but 
at a much higher intensity.

Section 7.4 – The Lights Pane
 The Lights pane is where you can customize each of the lights in your scene - adjust color, in-
tensity, position and other properties.  You can also use the Lights pane to load Light(s) Presets.  The 
Lights pane is located on the left hand side of the Hollywood Blvd layout inside the ‘Lights & Camer-
as’ activity.

 Hopefully, the first thing that you notice about the Lights pane is that it is similar to the Cam-
eras Pane, Posing Pane and Surfaces Pane.  The Pane is broken down into two pages – the Editor 
page and the Presets page.  The Editor page is where you can manipulate the properties for each 
light.  In the Presets page you can load premade Light(s) Presets.
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7.4.1 – The Editor Page
 The Editor page is divided into two col-
umns.  In the left hand column, the “Property 
Group View,” is a list of all the property groups 
for the currently selected light.  If you don’t have 
a current scene selection or if your current scene 
selection is not a light then nothing will be dis-
played in this column.  (If you haven’t loaded a 
light yet take the time to do so now and select it 
in the Scene pane).  In the right hand column, or 
“Property View,” you will find a list of individual 
properties.  The properties displayed on the right 
are determined by the property group that is se-
lected on the left.

 Each light has at least four default property groups – ‘General’, ‘Display’, ‘Shadow’ and ‘Light’.  
The ‘General’ group is where you will find transform properties.  The ‘Display’ group is where you can 
toggle scene visibility of the light in preview and in render.  The ‘Shadow’ group has properties that 
affect the shadows cast by the light.  The ‘Light’ property group has properties that affect the light 
such as color and intensity.  We will discuss important properties in the ‘Shadow’ and ‘Light’ property 
groups later in this section.

 The left column has options to display all properties for the 
selected light.  This is accomplished by clicking the ‘All’ filter in the 
left hand column.  The ‘Currently Used’ filter in the left column will 
display only properties that have been modified.

 You can change your light selection and load a new light using 
the Lights pane.  The drop down menu above the left column will 
list every light in the scene.  Clicking the drop down allows you to 
select a light from the menu.  At the bottom of the menu is an ‘Add 
a Light...’ option.  This provides an additional menu with actions to 
create new instances of each light type.

Shadow Type
 ‘Shadow Type’ is a property found in the ‘Shad-
ow’ property group.  By default each light loads without 
a shadow.  When ‘Shadow Type’ is set to ‘None’ the light 
won’t cast a shadow.  If you want your light to look natu-
ral it should cast shadows.

 There are two types of shadows to choose from in the ‘Shadow Type’ property – ‘Deep Shad-
ow Map’ and ‘Raytraced (Software Only).’  The ‘Deep Shadow Map’ option causes the render engine 
to calculate shadows based on an image - the “Shadow Map.”  This process is generally faster than 
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producing shadows with raytracing and is better for producing blurred or soft shadows.  Deep shad-
ow maps aren’t without their drawbacks.  “Shadow Bias,” or the positioning of the shadow in relation 
to the object that casts it, is often a problem when using a deep shadow map.

 Raytraced shadows are calculated by casting rays from light sources in the scene.  This 
means that shadow bias is less of a problem than with deep shadow maps.  The shadow is deter-
mined by the size of the object casting the shadow and its relative position to the light.  Raytraced 
shadows generally take longer to render than deep shadow maps, but the shadows will be much 
more accurate in their location and size.  They can often be grainy if the ‘Shadow Softness’ is set too 
high.  This can be counteracted by increasing the number of ‘Shadow Samples’.  If your system is 
robust enough, raytraced shadows is probably the best option.

Note: Shadows must be cast on something.  Make sure you have a ground plane, or other geometry 
in your scene to cast shadows on.

Shadow Softness
 ‘Shadow Softness’ determines how hard or 
soft the shadows are.  A soft shadow will be fuzzy or 
blurry around the edges, while a hard shadow will 
have a distinct edge.  Higher values for ‘Shadow 
Softness’ mean softer shadows.   These two images 
show the difference between a hard and soft shadow.

 You can manipulate the ‘Shadow Softness’ by using the slider on the property.  Click on the 
slider and drag left or right to change the value.  You can also enter a numeric value by clicking the 
value and entering a new value into the numeric field.  ‘Shadow Softness’ is found in the ‘Shadow’ 
property group.
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Illumination
 The ‘Illumination’ property is located in the ‘Light’ 
group.  By default ‘Illumination’ is set to on.  By clicking 
on the drop down you can also choose ‘Diffuse Only’, 
‘Specular Only’, or ‘Off.’  When the light is set to ‘Diffuse 
Only’ the diffuse channel of a surface is affected by the 
light and nothing else.  The same is true for ‘Specular 
Only,’ except that it is the specular channel that is af-
fected.  You can review the definitions of specular and 
diffuse in Chapter 3.

 You also have the option to turn ‘Illumination’ off.  This turns all contribution from the light off, 
and it no longer illuminates the scene.  You can also turn off the illumination in the Scene pane by 
clicking the eye to the left of the light so that it closes.

Color
 The ‘Color’ property is part of the ‘Light’ 
property group.  This property simply affects the 
color of light.  You can get some really great effects 
by changing the color of the light.  Cool renders may 
benefit from a blue or green light while warm renders 
can use yellow, red or orange to help set the mood of 
the final image.

 To manipulate ‘Color’ you can click the color widget on the property.  This will launch the ‘Se-
lect Color’ dialog and allow you to pick a color.  If you hover your cursor over any of the RGB values 
the cursor will change to a double arrow.  If you click and drag left or right you can change the value 
for that color.

Intensity
 ‘Intensity’ determines how bright the light is.  
We’ll get into what intensity values are best for each 
light later on in this chapter.  You can adjust ‘Intensi-
ty’ by using the slider.  Click on the slider and move 
it left or right to decrease or increase the intensity 
value.  You can also enter a numeric value by clicking 
the value for the property and entering a number into 
the numeric field.
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Spread Angle (Spotlight Only)
 The properties listed above are common 
to all lights.  ‘Spread Angle’ is a property unique to 
spotlights.  It determines how wide the light spreads 
out from the source.  Increasing the spread angle 
will increase the area illuminated by the light.  De-
creasing spread angle will focus the light into a nar-
row area.  You can manipulate this property using 
the slider, or by entering a value into the numeric field.

Falloff Start/End (Linear Point Light Only)
 ‘Falloff Start’ and ‘Falloff End’ are actually two 
separate properties but they work together and function 
similarly.  These two properties are unique to the linear 
point light.  When you load a linear point light into the 
scene you will see two spheres.  ‘Falloff Start’ is repre-
sented by the inner sphere and ‘Falloff End’ represents 
the outer sphere.

 Anything within the ‘Falloff Start’ sphere will be illuminated at the full value of the light.  As 
light leaves the inner sphere it begins to “fall-off” and the intensity of the light decreases.  Once light 
reaches the ‘Falloff End’ sphere the intensity is 0.  Anything outside of the ‘Falloff End’ sphere will not 
be illuminated.

 Both properties can be manipulated using their individual sliders.  You can enter numeric 
values for both properties using their respective numeric fields.  For more information on these two 
properties, and many other shadow and light properties please see this video: Lights Editor.

7.4.2 – The Lights Pane Presets Page
 The Presets page of the Lights pane is where 
you can load Light(s) Presets.  A Light(s) Preset will load 
a light, or set of lights into the scene.  Light(s) Presets 
may be designed for a specific scene, or for general use.  
Either way, a Light(s) Preset is a great way to get high 
quality lighting in your scene.

 The Presets page of the Lights pane is separated 
into two columns.  On the left hand side are categories, 
and on the right are files in the selected category.  The 
page functions just like the Smart Content pane.

 To load a preset, choose a category in the left hand column.  Once that category is chosen 
you can pick from the presets available in the right column.  Double click the preset icon or drag and 
drop the icon to load it into the scene.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/lighting/videos/lighting_editor/start
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Note: You can also load a Light(s) Preset from the Smart Con-
tent pane and the Content Library pane.

 When you load a Light(s) Preset it will replace all ex-
isting lights in your scene so be careful.  If you’d like a Light(s) 
Preset to add to your scene lights rather than replace them 
hold down the Ctrl key on the PC or Cmd key on the Mac while 
loading the preset.  This will launch the ‘Light Preset Load 
Options’ dialog.  In the ‘Action’ option near the top of this dialog 
you can choose whether or not to replace all of the lights, only 
the selected lights, or to simply add the lights from the preset 
to your scene without replacing any existing lights.

 DAZ Studio comes with several Light(s) Presets for the ‘Alchemy Chasm’ scene.  There are 
other Light(s) Preset that have a more general use.  If you’d like more Light(s) Preset you can pur-
chase more from the DAZ 3D Store.  You can learn more about Light Presets by watching this vide: 
Light Presets.

Section 7.5 – Viewing Through a Light
 You can manipulate a lights position and rotation in the Lights 
pane, or directly in the viewport using the Universal Tool.  These are 
great, especially for the point light and linear point light.  DAZ Studio 
also provides the option to make distant lights and spotlights your ac-
tive viewport view.  When you view through a distant light or spotlight 
you can manipulate it using the viewport controls.

 To view through a light first make sure that you have either 
a spotlight or a distant light (it won’t work with a point light or linear 
point light).  Open the view selection menu.  Below the cameras (if 
you have any in your scene).  You will see all of the distant lights and 
spotlights in your scene.  Select one of them to make it your active 
viewport view.

 When viewing through a distant light there is no perspective, just like the orthographic views.  
Spotlights do have perspective - with the spread angle of the light controlling the field of view.  You 
can use the orbit, pan and frame tools as well as the camera cube to move your light.  This allows 
you to aim your light with precision.  You can see from the point of view of the light, exactly what is 
being illuminated.  It allows you to make the subtle but important changes to your lighting, that other-
wise would be very difficult.

http://docs.daz3d.com/doku.php/public/software/dazstudio/4/userguide/lighting/videos/lighting_presets/start
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Section 7.6 – The 3 Point Rig
 While it is beyond the scope of this User Guide to get into the nuances of complex lighting, it 
is important to give you a good place to start.  The “3 Point Lighting Rig” is a common lighting setup 
found in both the 3D world, and the real world.  The setup consists of 3 lights illuminating a subject.  
The lighting is designed to highlight a single subject for a portrait.

 The setup is simple enough – three lights each placed at a different angle to the subject.  The 
three lights are called the “Key Light,” the “Fill Light” and the “Rim Light.”  In DAZ Studio you can use 
either spot lights or distant lights for any of the 3 lights.  Distant lights are simpler, but spot lights can 
give you more control over shadows and illumination.  We’ll discuss the purpose, placement, and 
relative intensity for each light below.

7.6.1 – The Key Light
 The key light is the main light in the 
scene.  Its job is to illuminate the face and front 
of your subject.  The key light should be placed 
in front of and pointed at the subject.  You have 
a bit of leeway when placing the key light.  Most 
people prefer to have the key light slightly offset, 
rather than directly on the subject.  A generally 
acceptable range is 45° to the left or right of the 
subject’s midline.  This gives you a 90° range 
to place the light.  In the real world we are used 
to light coming from above.  You can set your 
key light to light from below, or at the level of 
the subject.  However, most three point light rigs 
have the lights positioned above the subject and 
pointing down.

 Since the purpose of the light is to light the front of the model the light intensity should be set 
so that the subject is visible, but not washed out.  A good starting point for most light rigs is 100%.  
If the subject is washed out turn the intensity down.  The intensity value is something you’ll need to 
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play around with.  Remember there will be 3 lights in the scene, and they will all interact, so make 
sure you have all the lights in the scene before you decide on an intensity value.

7.6.2 – The Fill Light
 The job of the fill light is to fill in dark 
spaces left by the key light.  This means the fill 
light is also placed in front of the subject.  The fill 
light should be offset from the key light by about 
90°.  This means that if your key light is 15° 
to the left of your subject the fill light would be 
around 75° to the right of the figure.  This is just 
a general guideline; the purpose of the fill light is 
to fill in dark spots on the front and sides of the 
figure.  Keep this in mind when placing your fill 
light.

 The fill light shouldn’t be very intense.  
You want the fill light to fill in the blanks left by 
the key light, not overpower the key light.  Try 
starting the intensity of the fill light at around 
40% and work your way down from there if it is 
too bright.

7.6.3 – The Rim Light
 The rim light provides light from behind 
the subject.  When set up properly the light from 
the rim light will catch the edges of the subject 
and highlight them.  The rim light fills out and 
illuminates the rest of the scene.  The rim light 
will be pointed in the general direction of the 
camera causing the rest of the scene to look 
brighter.

 Just like the other lights, there are no 
hard and fast rules that determine placement, 
just guidelines.  The goal is to have the light rig 
illuminate the subject and make him or her stand 
out; it is important to keep this goal in mind 
when placing the rim light.  In general the rim 
light should be behind the subject.  You will want 
to offset the rim light so that it doesn’t combine 

with the key light and wash out the subject.  In general the rim light should be offset towards the fill 
light.

 Since the rim light is lighting the back of the subject the intensity on this light will be the bright-
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est of all the lights in the scene.  DAZ Studio allows you to overdrive lights (set the intensity above 
100%).  A good starting intensity value for the rim light would be around 120%, you can go up or 
down from there depending on your needs.

7.6.4 – Spot Rendering Your Lights
 Each of the lights in your scene will interact with other lights in 
your scene, and the surface of your figure in a way that can’t be dis-
played properly in the preview.  In order to see exactly how your light 
look you will need to render the scene.  We’ve covered spot render-
ing in  Chapter 3 and the process is no different now.

 To start a spot render first activate the Spot Render Tool in the toolbar.  Once the Spot Ren-
der Tool is active click and drag across the area you wish to spot render.  DAZ Studio will render that 
area in the viewport using your current render settings.

 Use the Spot Render Tool as well as the preview in the viewport to set up your lights.  Re-
member each light interacts with the others; changes to position, intensity and color will affect how 
the other lights in the scene appear.

Section 7.7 – Saving a Light(s) Preset
 So you’ve set up your three point lighting rig, or an-
other light set up and you are in love.  You know that this light 
set will look great in other scenes.  DAZ Studio allows you 
to preserve all your hard lighting work with a Light(s) Preset.  
A Light(s) Preset will save information about position, color, 
intensity, etc. for the lights in your scene.

 To save a Light(s) Presets make sure you have the 
light you want to save the preset for selected in the Scene 
pane.  If you want the preset to save for all lights your scene 
selection is irrelevant.  Once your selection is made go to File 
→ Save As → Light(s) Preset…  This will launch the ‘Filtered 
Save’ dialog.  In the ‘Filtered Save’ dialog you can name your 
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preset and choose a location to save to.  Once you are ready, click ‘Save.’  Make sure you take note 
of where you are saving your preset to so you can find it later.

 Once you click ‘Save’ the ‘Light(s) Preset 
Save Options’ dialog will launch.  This dialog is 
broken into three panels – ‘Animation Range’, 
‘Light Data’ and ‘File Options.’  The options in 
‘Animation Range’ allow you to choose whether 
the preset applies for the ‘Current Frame Only’, 
or over an ‘Animated Range’ specified by the 
‘Start Frame’ and ‘End Frame.’  The ‘Light Data’ 
options allow you to choose whether the preset 
is for the ‘Selected Light(s),’ or for ‘All Lights’ in 
the scene.  Finally, ‘File Options’ allows you to choose whether or not to compress the file.  Once you 
have your preset options set, click ‘Accept’ and DAZ Studio will save the Light(s) Preset.

 You will be able to load the Light(s) Preset from the Presets page of the Lights pane.  Open 
the Presets page and look under the ‘Uncategorized’ category.  You can double click the icon for your 
preset, or drag and drop it into the scene to load it.

Section 7.8 – Wrap-Up
 Congratulations on making it through this chapter on lighting.  You should now be able to cre-
ate and/or load a distant light, spotlight, point light and linear point light into your scene.  You should 
be able to manipulate the properties for each light to properly light your scene.

 Good lighting takes practice and patience, just like everything else with 3D.  There is no mag-
ic “Make Art” button that will do the work for you.  Hopefully though, you’ll find the process of lighting 
your scene rewarding.  Each artist is unique; you can use lighting to distinguish yourself from those 
around you.
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Rendering
The Fruits of Your Labors

Section 8.1 – Introduction
 Rendering is the process taking your 3D scene and converting it into a 2D image or anima-
tion.  The whole point of DAZ Studio is to help you produce great artwork, in the form of renders.  
Rendering is the last step in your DAZ Studio workflow, and the point where you get to reap what you 
sow, so to speak.

 When you render a scene the software calculates RGB values for each pixel based on light, 
surfaces, poses, shaping, etc.  These pixels form your final image.  There is more to rendering than 
just clicking the render button.  Your render settings will determine the overall quality and appearance 
of the image.  You may have a fantastic character with a great shape, texture, a pose that stuns and 
lighting to match, but if your render settings are not set correctly your final image will be poor in quali-
ty.

 In this chapter we’ll go over the basic render 
settings you will need to produce a high quality im-
age.  We’ll talk about how to set your image size and 
aspect ratio.  Finally, you’ll learn how to render your 
image and save that image in a 2D file format that 
can be accessed later.

Note: In this chapter we’ll be in the ‘Render’ activity using the Hollywood Blvd layout.
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Section 8.2 – The Render Settings Pane
 The Render Settings pane is where you can 
see and customize all of your render settings.  The 
pane is located on the left hand side of the DAZ Studio 
interface.  The pane is broken down into two pages – 
‘General’ and ‘Advanced.’  The ‘General’ page contains 
basic render settings such as ‘Quality’, ‘Render Style’, 
and ‘Dimensions’.  The ‘Advanced’ page contains all 
of the settings found in the ‘General’ page but includes 
more advanced render settings.  The following sections 
will go over the settings in the General page as well as 
a select few settings from the Advanced page.

Section 8.3 – Render Quality
 The ‘Render Quality’ setting is available in both the General and Advanced pages of the Ren-
der Settings pane.  This setting is fairly straight forward – Higher quality means a slower render and 
vice versa.  With this setting you can choose to sacrifice quality for speed.  This setting has a promi-
nent location at the top of the Render Settings pane.

 The highest quality render setting is 4.  At 
this setting DAZ Studio uses the software 
render engine to render your scene.  You will 
see the full effect of your surfaces, lights and 
shadows with this render setting.  A software 
render uses your computer’s processor to 
do the calculations required for the render.  
This means that your processor will be a big 
factor in how long the render takes.

 The lowest quality setting is just an 
OpenGL preview.  It is essentially a snapshot 
of what you see in the viewport.  A render 

at this level will have lights at their lowest quality, and no shadows.  This render setting is useful for 
creating a 2D image of what you see in your viewport.  You will find that the render is quick - almost 
instantaneous.

 The other two settings are a compromise between speed and quality.  Settings 1, 2 and 3 
all use your graphics card to do the render calculations.  This means that the speed and quality are 
determined by your graphics card.  However, no matter how nice your graphics card is, a software 
render will always be of higher quality.  Levels 2 and 3 are good for previews, but final renders should 
always use the best quality.
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8.4 – Render Style
 The ‘Render Style’ render setting al-
lows you to render your image using the exist-
ing material settings in the scene, or to render 
the image with a cartoon look.  If the ‘Render 
Style’ setting is set to ‘Cartoon’ then DAZ 
Studio applies a toon version of the default 
surface shaders to all surfaces that used the 
DAZ Studio default surface shader.  All of the 
settings from the default surface shader are 
carried over to the toon shader.  When the ‘Default’ is chosen for this setting no change is made to 
the materials and they are rendered as is.  Both shaders are great, and it is definitely worth rendering 
the same scene with both shaders just to see the difference.

8.5 – Dimensions
 The ‘Dimensions’ settings are available in both 
the General and Advanced pages.  The settings in 
this section allow you to determine the overall size 
and aspect ratio of your rendered image.  “Size” 
is determined by the number of ‘Pixels’, while the 
“Aspect Ratio” is determined by the ‘Aspect.’  DAZ 
Studio also provides a few preset aspect ratios 
commonly used in cinematography and photogra-
phy, along with an ability to save your own.
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8.5.1 – Showing the Aspect Frame
 By default the “Aspect Frame” is turned off.  Turning the aspect frame on will allow you to see 
exactly what area of your scene will be rendered.  To turn the aspect frame on, open the viewport op-
tions menu (see Section 2.4.3 for a review) and choose the ‘Show Aspect Frame’ option.  You should 
see the aspect frame appear unless you have ‘Active Viewport’ as your aspect ratio setting.

8.5.2 – Preset
 The ‘Preset’ setting is a drop down menu 
that allows you to choose a preset aspect ratio.  
There are several available, such as 4:3, 16:9, 
Super 8mm and more.  Click on the drop down 
menu to see all of the presets available.  If you’ve 
created your own aspect ratio you can use the 
‘Save Preset…’ button to save that aspect ratio 
for later.  Once the preset is saved you will find it 
in the ‘Preset’ drop down list.

8.5.3 – Pixels
 In the ‘Pixels’ fields you can enter the 
number of pixels you want in your final render.  The first field is the height and the second field is the 
width.  If the ‘Constrain Proportions’ option is checked, updating one field will automatically update 
the other field so that the proportions match.  Keep in mind that the more pixels in your render the 
longer the render will take to complete.

8.5.4 – Aspect
 The ‘Aspect’ fields allow you to determine the relative height and width of your image.  The 
easiest way to set your aspect is to use one of the preset aspects from the preset drop down menu.  
If you’d like a custom aspect you can set it here.  All you need to do is click in one of the fields and 
enter a numeric value.  The first field represents the height, and the second field represents the width 
of the image.  Changing the ‘Aspect’ values will update the aspect frame in the viewport if it is turned 
on.
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Section 8.6 – Advanced Render Settings
 Even when you have your quality setting at its highest 
there are still things you can do to improve the overall quality of 
your render.  The render settings in the Advanced page of the 
Render Settings pane give you further control over the quality of 
your render.  You can adjust these settings to increase speed or 
quality.

 The render settings discussed in this section can be found 
in the Advanced page of the Render Settings pane when the 
render quality setting is 4.  While there are many render settings 
that could be discussed we’ve chosen three of the most import-
ant settings in terms of quality.  They are ‘Max Ray Trace Depth’, 
‘Shadow Samples’, and ‘Shading Rate.’

8.6.1 – Max Ray Trace Depth
 ‘Max Ray Trace Depth’ determines 
the number of light bounces for a single 
ray calculated by the render engine.  The 
default max ray trace depth is 2.  This is 
sufficient for most renders.  The only time 
you need to turn max ray trace depth up 
is if you have multiple reflective surfaces 
in your scene.  Increasing max ray trace 
depth can drastically increase your render 
time, so make sure you need the added 
ray bounces before you increase the value.

8.6.2 – Shadow Samples
 ‘Shadow Samples’ determines how 
many samples the render engine takes to 
create a shadow.  More samples means a 
higher quality shadow but a longer render 
time.  Lowering the number of samples 
will decrease render time but you may get 
grainy, low quality shadows.

 The default number of samples is 16.  Depending on the number of lights, the prominence of 
shadows in your scene and your shadow softness you can turn this value up or down.
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8.6.3 – Shading Rate
 Your ‘Shading Rate’ determines 
how detailed your render is.  A high-
er shading rate means a faster render.  
However, with a faster render you sacrifice 
details.  Your shading rate should be de-
termined by your scene.  If you are doing a close up portrait your shading rate should be low so you 
can capture as much detail as possible.  On the other hand, if the subject of your scene isn’t close up 
you can turn the shading rate up, as you won’t be able to see the fine details anyway.

 The default value for ‘Shading Rate’ is 1.00.  This is a great baseline value, and most renders 
will be sufficient with this setting.  However, if you find your render is taking far too long try turning the 
shading rate up.  Does your render need finer detail?  Turn the shading rate down.
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Section 8.7 – Render Settings Preset
 Render Settings Presets allow you to save your 
existing render settings, or load previously saved ren-
der settings.  The preset contains information for every 
setting in both the General and Advanced page of the 
Render Settings pane.  When loaded, a Render Settings 
Preset will replace ALL of your current render settings, 
with the render settings contained in the preset.

8.7.1 – Saving a Render Settings Preset
 Saving a Render Settings Preset is simple.  First 
make sure your render settings are at the values you 
desire.  Next, select File → Save As → Render Settings 
Preset… from the main menu bar.  This will launch the 
‘Filtered Save’ dialog.  In the ‘Filtered Save’ dialog you 
can give your preset a name and choose the location 
you wish to save it to.  Take note of your save location 
and the name of the preset so you can find it later.  Once 
you’ve finalized your save location and name click ‘Save’ 
and DAZ Studio will save the preset.

8.7.2 – Loading a Render Settings Preset
 You can load a Render Settings Preset from either the Content Library pane or the Smart 
Content pane.  Simply browse through your content until you find the preset and double click the pre-
set to load it.  If you have just saved a Render Settings it can be found in the ‘Uncategorized’ catego-
ry in the Smart Content pane.

Section 8.8 – Rendering
 You’ve got your scene set up, the lighting is just 
right, the materials look great, you’re composition and 
framing are spot on, and you’ve got your render settings 
where you want them.  Congratulations on building your 
scene, it’s now time to start your final render.

 Rendering is a resource intensive process.  De-
pending on the power of your machine and the complex-
ity of your scene your render could take a few seconds, 
minutes, hours, or even days.  Because of the variability 
in hardware and scene complexity it is always a good 
idea to save your scene before beginning any render.  
That way if anything goes wrong you won’t lose all of 
your hard work.  To save your scene, go to File → Save.
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8.8.1 – Rendering the Image
 Once your scene is saved and your render settings are finalized you 
can begin your final render.  To start the render process you can click the 
‘Render’ button at the top of the Render Settings pane, click the ‘Render’ 
button in the toolbar, choose Render→Render from the main menu bar, or 
use the hotkey Ctrl+R on the PC or Cmd+R on the MAC.

 By default the render will open a new window.  While the scene is rendering you won’t be 
able to do anything else in DAZ Studio.  You can watch the progress of the render in the “Render 
Window.”  If at any time you need to cancel the render you can do so by clicking the ‘Cancel’ button 
in the bottom right corner of the render window.  When the render is complete the cancel button will 
change to a ‘Close’ button.

8.8.2 – Saving the Render
 Once your render is complete you still need to save the render.  If you are satisfied with the 
results you can save the render from within the render window.  If you’d like to discard the render 
simply click the ‘Close’ button.

 To save the render you must first enter a name for the image in the ‘Name’ field.  Next choose 
a file format from the drop down menu.  You can choose from .jpg, .png, .tiff, and .bmp for still imag-
es.

 After you’ve chosen a name and a file extension you’ll need to choose a save location.  By 
default the render will be saved to DAZ Studio’s “Render Library” - which can be viewed from the 
Render Library pane.  You can use the + key to add a folder within the render library.  If you’d like to 
choose a different save location choose ‘Folder’ from the drop down menu on the left.  You can then 
use the ‘…’ button on the right to open a browsing dialog and choose a save location.
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 When your name, file format, and save location are finalized click ‘Save’ to save the render.  
DAZ Studio will save the 2D image in the location you have chosen.  You can then share this image 
with friends and family or colleagues.  You can open the image in a 2D editing software like Adobe® 
Photoshop®.

Section 8.9 − Wrap-Up
 Congratulations on finishing your render.  We love to see what our new users are doing with 
DAZ Studio and DAZ Content.  Feel free to share your artwork in our forums and in our galleries.  As 
your skills progress you may want to consider entering a render contest in one of our forums.  We 
have contests available for every skill level.  Whether you decide to share your art with the world, or 
keep it personal to you, don’t stop rendering.  Keep working in 3D and your skills will improve.

http://www.daz3d.com/forums/
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